Style Manual for Papers and Theses

Detroit Baptist Theological Seminary

Second Edition, Revised

Interpreted from Kate L. Turabian’s Manual for Writers, 7th ed.,
with field-specific excerpts from the SBL Handbook of Style.
Prepared by Mark A. Snoeberger
INTRODUCTION

The materials in this manual are binding upon a paper or thesis writer at Detroit Baptist Theological Seminary. Style procedures in this manual are based significantly on Kate L. Turabian, *A Manual for Writers of Research Papers, Theses, and Dissertations*, 7th ed. (University of Chicago Press, 2007) and the capitalization and abbreviation guidelines on *The SBL Handbook of Style for Ancient Near Eastern, Biblical, and Early Christian Studies* (Hendrickson, 1999) and Robert Hudson, *A Christian Writer’s Manual of Style* (Zondervan, 2004). While this manual attempts to be as thorough as possible, some details, especially obscure bibliographic forms and abbreviations, are necessarily omitted. Writers should consult Turabian and the *SBL Handbook* for issues not addressed in this manual. For style issues not addressed in Turabian, writers should consult *The Chicago Manual of Style*, 15th ed. (University of Chicago Press, 2003). When the instructions in this manual conflict with any of these primary sources, however, writers are to follow the instructions in this manual. For specific projects individual professors may also make modifications to these instructions at their discretion.

PART 1: PLANNING THE PAPER

Most seminary papers are primarily library studies, or what Webster calls a “close searching” of written materials, which involves not only a studious inquiry into the subject but also a critical examination, assessment, and interpretation of the materials found. The results should be set forth in an accurately, clearly and forcefully expressed, well organized, and properly documented paper.

There are five basic parts of paper-writing: (1) reading broadly in the field and specifically the course topic, (2) choosing a specific question to answer, (3) collecting and reading research materials on that specific question, (4) planning a paper that answers the question, and (5) writing the paper. Every seminary student should be continuously involved in steps 1–3, sometimes reading broadly and sometimes pursuing narrower topics of interest to conclusions. This manual will assist especially in these latter steps of paper-writing.

Choosing a topic: While reading broadly within a given area of study, the student will generate questions that call for more exhaustive research. Some of these questions are good topics for research papers. Some are not. A good research topic will be:

- **Worthwhile.** This is a very subjective characteristic. A good research question will have some contemporary value, will not find a unanimous answer among writers, and should interest the student. Sometimes the instructor will assign topics or lists of suggested topics to assist in this selection.
- **Manageable.** In general, students tend to think of subjects too large to be treated satisfactorily in the length of paper assigned. Avoid a topic calling for a background of knowledge that you do not possess.
- **Feasible.** Choose a topic for which there is available information in libraries to which you have access. You will need to secure original sources.
- **Acceptable to the instructor.** If there is any doubt, ask.
Collecting bibliographic sources. With the vast amount of materials available in today’s theological libraries, finding good materials can be a daunting task. But the task has actually changed very little. Look for materials in this order:

- *Encyclopedia and dictionary articles.* These provide a survey of the topic, together with a short bibliography of the most pertinent sources.

- *Bibliographies.* Most topics already have some sort of bibliography available. Some are bound, annotated bibliographies and others take the form of periodical articles, but most are simply appended onto published books and dissertations on the topic.

- *Card catalogs and OPACs* (Online Public Access Catalogs). Today’s technology makes it possible to research a topic through online catalogs that inform the researcher what is available not only in his local library, but also in hundreds of other libraries whose resources are available via interlibrary loan for a small fee and a short processing period. (Most interlibrary loans take between one and two weeks to fill.)

- *Periodical indexes.* As the student advances in his studies, periodical articles and essays will become a greater percentage of his sources. These sources are usually very detailed, and represent the most up-to-date materials on given topics. It is essential for students to learn to use these resources.

- *Footnote trails.* So long as a student is still reading, his collection of bibliographic sources is not complete. While reading books, essays, and periodicals, the student will become aware, through footnotes, of other pertinent sources. These footnote trails often prove to be the best bibliographic source of all.

Evaluating bibliographic sources. The bibliography in a research paper should not be a list of every work the student can discover which relates to his topic. It should be limited to those sources that actually proved useful to the student. Several questions may be asked in evaluating sources:

- *Is it a primary or secondary document?* Secondary documents provide commentary on previous discussion by other authors. One cannot avoid using these. However, these should never be used exclusively. See also the note on secondary citation below.

- *Is the author qualified?* A serious academic paper concentrates on materials published by scholars writing within their field.

- *Is the author biased?* An exploration of authors’ denominations, experiences, schools, instructors, and other history can unearth significant biases that can jeopardize academic professionalism.

- *Is the source up to date?* Though we have a rich theological heritage, old scholarship is not necessarily the best scholarship. Modern linguistic and archaeological studies, to say nothing of the compounded refinement of exegesis and theology, have vastly improved the quality of commentaries and have refined and contemporized theological discussions. While the contemporary student stands on the shoulders of earlier creeds and theological studies, he must also refine and increase his knowledge of truth by probing newer studies as well.
**Gathering bibliographic data.** From the very beginning of his research the student is urged to be meticulous in gathering bibliographic data. Such a habit will eliminate a hasty scramble through the library stacks to retrieve a publication date, page numbers, or a translator’s name.

Be careful to record the full names of all authors, editors, and translators. When dealing with reprints, be careful to record the reprint date as well as the original copyright date if available. When using a periodical be sure to note the volume, issue, and date of the article, and record the inclusive page numbers of an entire periodical article. Give attention to names of monograph series and to total volumes in a multi-volume set. This information will all be necessary for a correct bibliographic entry.

In its broadest (and normal) form the bibliography includes only those sources actually employed by the student—those that contributed to the development of the content of the paper. In its narrowest form it may include only those sources actually cited. DBTS papers and theses should normally contain a bibliography of sources consulted, though it will usually be titled simply “Bibliography.” A bibliography should not be divided into sections with such titles as “Books,” “Lexical Aids,” “Commentaries,” etc. All items should be integrated into one complete listing with all bibliographic information.

**Documentation.** All papers must be adequately documented. Documentation (footnotes) must not be limited to only those instances of direct quotation. A summary or statement of an author’s position, even when reworded by the student, must be documented. Frequent quotation is not synonymous with good documentation. A paper may have very few quotations yet be well documented.

A research paper should be an original critical evaluation and analysis of all available data. A major element of a research task is to evaluate each author and be able to express his view in one’s own words. Do not include quotations for the sake of including quotations. Direct quotations are usually necessary only when an author’s exact words are essential to the argument or when a significant thought has been expressed particularly well, and should be used very sparingly. Gordon Fee (*New Testament Exegesis*, 3rd ed. [Philadelphia: Westminster/John Knox, 2002], p. 34) gives the following advice:

- Quote when it is necessary or important to use the very words of an author so as not to misrepresent.
- Quote when it is necessary for a clear or convincing presentation of an option. Many times a quotation of this kind will stand at the beginning of a section or paragraph as a point of departure.
- Quote when it is useful for the psychological impact on the reader. For example, it is often useful to quote some well-known authority who holds the opinion you are contending for. Sometimes this is especially helpful if what is said may be contrary to one’s ordinary expectations.
- Quote when an author clearly says something better than you could, or when it is said in a clearly memorable way.

Never make a secondary citation if the original source is available, and never cite an electronic source if a print source is available. If electronic citation is unavoidable, follow the style demonstrated on pages 35–38 of this manual.
PART 2: WRITING THE PAPER

Preparing to draft. No one should attempt to draft until he (1) knows the question he plans to answer, (2) has done sufficient reading to know his answer, (3) has molded that answer into a thesis, and (4) has an outline (usually written) he plans to follow in proving his thesis. An outline will allow the student to:

- identify what information he already has on a topic.
- identify a logical arrangement for this information.
- confirm a controlling idea (thesis) for the paper.
- discover places where his information is incomplete as well as those where it seems irrelevant. This is essential for further collection of material, reading, and note-taking.

Drafting the paper. There is no “right” way to draft. Booth, Colomb, and Williams identify two styles of drafting: a “quick and dirty” style where the writer, as quickly as possible, puts everything on his paper without thought for editing issues, and a “slow and clean” style where the writer creates a polished first draft (The Craft of Research, pp. 165–66). Both styles, however, involve multiple revisions and rewritings, the single most essential part of lucid writing.

Writing style. Seminary papers should reflect an attitude that is formal, detached, and serious. Their purpose is to present your materials factually in an accurate, complete, and well-ordered report. Humor and witticisms are unacceptable; emotionalism and exclamations should be minimized; contractions, slang, and popular clichés (e.g., “this doesn’t hold water”) should be eliminated. Avoid frequent references to yourself in the first person. This limits use of the editorial “we” as well as “I.” Eliminate usage of second person pronouns (you should not, etc.). Restructure sentences to avoid overuse of “this writer” or “the writer.” Avoid unnecessary repetitions by employing synonyms and varied expressions (use a thesaurus). Do not use titles (brother, Dr., etc.) unless they are essential.

Grammar and syntax. Struggle to construct good sentences. Vary words and, of course, spell words correctly. Since use of the passive voice softens and weakens statements, use primarily (though not exclusively) the active voice. Avoid repetitive phrases and transitional devices, and do not use a transitional device in every paragraph. Eliminate faulty parallelism. Construct coherent, unified paragraphs with a single thesis. Vary sentence structure, but avoid unnecessarily long sentences, paragraphs, and sections. As a general rule, if a sentence extends longer than three lines it will usually help to divide it into two sentences. If a paragraph extends longer than one page it can probably be logically divided into two paragraphs. If a section extends longer than five pages without a new subheading, the organization can probably be improved by employing another level of subheading to divide the material.

Brevity. A long paper is not necessarily a good paper. In fact, it usually is a bad one. Though there are many examples to the contrary, academic writing need not be verbose. The excellent writer, whatever his discipline or audience, must trim the “fat” (unnecessary words) from his writing. This is not to say, however, that his writing must be reduced to the simplest reading
level. The academic writer must learn to use complex and varied sentence structure and a depth of vocabulary commensurate with his audience. A simple but popular guide to developing a concise style is William Strunk, Jr., and E. B. White, *The Elements of Style*, 4th ed. (Boston: Allyn and Bacon, 2000).

**PART 3: FORMATTING THE PAPER**

**Computer settings for research papers.** All papers must be prepared on a computer or electronic word processor. Microsoft Word is highly recommended though not required. Supplemental templates and sample pages formatted in Microsoft Word are available on the DBTS website for the convenience of the student.

**Paper.** Use quality 20-pound weight paper (standard copy paper). Do not use colored paper or lighter “typing” paper. Normal classroom papers are to be secured with a single staple in the upper left hand corner. Do not use report covers of any kind. Th.M. theses are bound.

**Fonts.** Use a black, 12-point Times New Roman font throughout the body, preliminary pages, and bibliography of the paper. Use the identical font style in footnotes, but reduce the font size to 10 points. Do not use monospaced or sans serif fonts. See section 5 for protocol differences between typewritten monospaced fonts and computer-generated proportional fonts.

Titles of whole published works (books, periodicals, newspapers, magazines, etc.) should be italicized. Other titles (e.g., syllabi, theses, or essays and articles that are parts of a published work) should be enclosed in quotation marks.

Sparing use of italics may also be used for emphasis. Under no circumstance should the student make emphasis using underlining, capitalization, bold fonts, or altered font sizes and styles, except as specifically required by this manual for headings. Italics also set apart isolated foreign words and phrases that may be unfamiliar to the reader, but not for foreign words that have become such a part of common English parlance that they appear in the *Merriam Webster’s Dictionary* (e.g., contra, vis-à-vis). Latin abbreviations are not italicized.

The names of modern versions of the Bible are placed in italics, unlike the names of important historical versions of the Bible, which are set in Roman (non-italic) type:

- the Breeches Bible
- the King James Version
- *The New International Version*  
- *The Jerusalem Bible*
- *The New King James Version*
- the Vulgate

A word referred to as a word should be italicized (except for words written in Greek and Hebrew fonts). Its definition should be in quotation marks. However, when a word is quoted from a specific context, quotation marks, not italics, should be used:

- Early Methodist ministers used the word *liberty* to describe an openness to God’s Spirit in their preaching.
- By *feretory* hagiographers mean “a shrine in which a saint’s bones are deposited and venerated.”
• The word *world* has various meanings in Scripture: in John 3:16, for instance, the Evangelist writes “world” to denote the inhabitants of our planet, not the broader cosmos. The Greek word κόσμος is the term used.

Greek, Hebrew, and Aramaic terms may not be transliterated in seminary papers except within the title, when quoted directly from another source, and in unusual cases where comparative linguistics is involved. Students may not insert Greek, Hebrew, and Aramaic terms by hand but must use non-italicized computer fonts. Greek words should include all accents and breathing marks, and Hebrew and Aramaic words should be properly pointed. A Greek word that begins a sentence must have its first letter capitalized as in English.

Small caps should be used for such abbreviations as A.D., B.C., P.M., MS, and MSS. Abbreviations of translations and versions of Scripture are usually set in small caps. See pages 37–39 of this manual for a listing of proper abbreviations for the various versions.

**Line spacing.** Use double-spacing in the body of all papers. Use single-spacing for the contents of footnotes and bibliographic entries (but double space between each entry), for multi-line headings (except on the title page, where a double space is used), and for block quotations. Your word processor should be set to allow widows and orphans.

**Margins.** Use a one-inch margin on all four sides for research papers. For the Th.M. thesis, use a 1½-inch left margin to accommodate binding. A two-inch upper margin is used for major section headings (for normal classroom papers this includes the first page of text and the bibliography; for theses, this also includes the first page of each chapter and each section in the front matter).

**Indentation.** Use left justification only; do not use right or full justification. The first line of each paragraph and footnote is indented ½ inch. Indent a block quotation ¼ inch from the left margin, and indent the beginning of each paragraph within a block quotation another ¼ inch (½ inch total). Block quotations should not have a paragraph indentation unless the material quoted begins a new paragraph in the source being quoted. Use a ½-inch hanging indentation for bibliographic entries (i.e., the first line flush with the left margin and each succeeding line indented ½ inch).

**Page numbers.** Pagination in Arabic numerals (1, 2, 3...) begins on the first page of text, and continues through the bibliography. Page numbers on the first page of each document section (see below for a delineation of each of these) should appear centered at the bottom of the page ½ inch from the edge of the paper. On all other pages of text the page number should appear one inch from the right edge of the paper and ½ inch from the top edge.

Preliminary pages are numbered with small Roman numerals (i, ii, iii, iv, v, etc.) centered at the bottom of the page, ½ inch from the bottom edge. However, since pages that have no text material receive no page number, these will not appear on normal classroom papers. In the Th.M. thesis the actual numbering begins with v (the first page of the table of contents) since the title pages counts as page i, the blank page which follows counts as page ii, the abstract counts as page iii, and the acceptance page counts as page iv.
Fonts
Click on the Format drop-down menu.
Choose Font.
Select Font: Times New Roman.
Select Size: 12
Select Font Style: Regular or Italics as appropriate.
Check Effects: Small Caps as appropriate.
Click OK.

Note: You can perform these steps more quickly by displaying the Formatting Toolbar on the View drop-down menu.

Line Spacing, Indentation, and Alignment
Click on the Format drop-down menu.
Choose Paragraph.
Choose the Indents and Spacing Tab
Select Alignment: Left.
Under Indentation select:
Left: 0.25” for block quotes.
Special: First line by 0.5” for body text and footnotes.
Special: Hanging by 0.5” for bibliographic entries.
Under Line Spacing select:
Double for regular text.
Single for footnotes, bibliographic entries, and block quotes.
After: 0 pt for regular text.
After: 12 pt for bibliography and footnote entries.
Choose the Line and Page Breaks Tab
Unselect all four boxes under Pagination.
Click OK.

Margins
Click on the File drop-down menu.
Choose Page Setup.
Choose the Margins tab.
Set top, bottom, left, and right margins at 1”.
Set header and footer margins at 0.5”
Click OK.

Pagination
Click on the File drop-down menu.
Choose Page Setup.
Choose the Layout Tab.
Click Different First Page.
Click OK.

Click on the Insert drop-down menu.
Select Page Numbers.
Select Position: Top of Page (Header).
Select Alignment: Right.
Unselect Show number on first page.
Click OK.

Click on the View drop-down menu.
Select Header and Footer.
Scroll to the first page of text and enter the First Page Footer text box.
In the Main Formatting Toolbar select Center.
In the Special Header/Footer Toolbar select Insert Page Number
Close the Special Header Footer Toolbar.

For Th.M. Theses only:
Click on the Insert drop-down menu.
Choose Page Numbers.
Choose Format
Choose the appropriate Number Format for the section in view:
(1, 2, 3…) for text pages.
(i, ii, iii…) for preliminary pages.
To enable continuous numbering of pages and footnotes, check the box Continue from previous section.
Click OK.
Formatting Your Paper in Microsoft Word 2007: How to Do It

Fonts

Click on the Home tab (default).
Open the Font dialog box launcher.
Click on the Font tab (default).
Under Latin Text select the following:
  Font: Times New Roman*
  Size: 12*
  Font Style: Regular, Bold, or Italics as appropriate.*
  Effects: None, All caps, or Small Caps as appropriate.
Click OK.†

Line Spacing, Indentation, and Alignment

Click on the Home tab (default).
Open the Paragraph dialog box launcher.
Click on the Indents and Spacing tab.
Under General, select Alignment: Left.*
Under Indentation select:
  Before Text: 0.25” for block quotes.*
  Special: First line by 0.5” for body text and footnotes.*
  Special: Hanging by 0.5” for bibliographic entries.*
Under Line Spacing select:
  Double for body text.
  Single for footnotes, bibliographic entries, and block quotes.
  After: 0 pt for regular text.
  After: 12 pt for bibliography and footnote entries.
Click on the Line and Page Breaks tab.
  Uncheck all four boxes under Pagination, including the box marked Widow/Orphan Control.
Click OK.†

Margins

Click on the Page Layout tab.
Open the Margins drop-down menu.
Select Custom.
For normal classroom papers, specify 1” for all four margins.
For Th.M. theses, specify 1” for the top, bottom, and right margins, and 1.5” for the left margin.
Click OK.†

Sections

When beginning a new section (e.g., the body, bibliography, and in Th.M. theses, chapters) click on the Page Layout tab.
Find the Page Setup tab.
Click on Breaks.
In the Drop-down menu, select Section Breaks, Next Page.
Do not use the Insert/Page Break option for this function.
Note: This step is necessary to facilitate pagination (see below).

Pagination

For regular body text:
Click on the Insert tab.
Find the Header & Footer tab.
In the Page Number drop-down menu select Top of Page.
In the Top of Page drop-down menu select Plain Number 3 (right justified).
A Design toolbar will immediately appear.
Under the Options tab check Different First Page.
While in the first page of your paper, find the Header & Footer tab again.
In the Page Number drop-down menu select Bottom of Page.
In the Bottom of Page drop-down select Plain Number 2 (centered). Note: There is a glitch in MS Word 2007 that places a line space after the page number at the bottom of the page. This extra space should be removed.
Click on Close Header & Footer.

For preliminary pages of the Th.M. thesis:
Click on the Insert tab.
Find the Header & Footer tab.
In the Page Number drop-down menu select Format Page Numbers
From the Number Format drop-down menu select (i, ii, iii…).
Click OK.
On the first page of text, repeat these steps, selecting number format (1, 2, 3…). In the Number Format drop-down menu be sure to uncheck the Continue from previous section option and specify that page numbering is to start at page 1.

†These changes may be made part of the “normal” template by clicking default instead of OK.

#These actions may be performed more quickly in the respective minibars.

*These actions may be performed more quickly in the ruler. To use the ruler, click on the View tab, find the Show/Hide box, and check the box for Ruler.

†These changes may be made part of the “normal” template by clicking default instead of OK.
PART 4: PARTS OF THE PAPER

A standard classroom paper has three sections: (1) the title page, (2) the body of the paper, and (3) the bibliography. The Th.M. thesis has seven sections: (1) the title page (followed by a blank page), (2) the abstract, (3) the acceptance page, (4) the table of contents, (5) the list of abbreviations, (6) the body of the paper subdivided into chapters, and (7) the bibliography. Each section (with the exception of the title page) begins with a section header centered in ALL CAPS two inches from the top edge of the page.

Title page: The title should express in the clearest possible terms the subject matter of the thesis. Avoid the extremes of short, cryptic titles and unnecessarily long, ostentatious titles. Eye-catching titles, arcane allusions, and clever gimmicks are better suited to the best-selling books than to scholarly papers. Superfluous phrases (“An Intensive Examination of…”) should be omitted. Proper grammar and punctuation should be observed. If Greek and Hebrew words are used in the title, they should be transliterated.

Normal classroom papers (see sample page A): Each line of the title page is centered between equal margins of 1 inch. The lines are as follows:

- The school name (Detroit Baptist Theological Seminary) appears 1½ inches from the top edge of the page.
- The title of the paper appears in ALL CAPS beginning 2¼ inches from the top edge of the page. No line of the title should exceed 5 inches; lines of 4 inches or longer may be subdivided. Arrange the lines in an inverted pyramid and double-space them. If the title includes both a title and subtitle, the title should appear on one line followed by a colon, and the subtitle should appear on a separate line or lines. The inverted pyramid rule may be suspended only in this situation. A title should rarely exceed three lines, and may not exceed four lines.
- The word by appears 5¼ inches from the top edge of the page, followed by a double space and the author’s full given name (a middle initial is acceptable).
- Nine inches from the top edge of the page is a line containing three elements: (1) the course name followed by a colon, (2) the course number followed by a comma, and (3) the regularly scheduled meeting time for the class.
- After a double space include the name of the instructor followed by another double space and the due date for the paper.

Th.M. theses (see sample page B): Each line of the title page is centered between a left margin of 1½ inches and a right margin of 1 inch. The lines are as follows:

- The title of the paper appears in ALL CAPS beginning two inches from the top edge of the page. The same rules for classroom paper titles apply to thesis titles.
- The word by appears 5¼ inches from the top edge of the page, followed by a double space and the author’s full given name (a middle initial is acceptable).
- Nine inches from the top edge of the page the following single-spaced entry should appear in sentence capitalization format:
Submitted in partial fulfillment of requirements
for the degree of Master of Theology at
Detroit Baptist Theological Seminary
May 2001

Blank page. A blank page should only be used in theses, not normal classroom papers.

Abstract. The Th.M. thesis (not normal classroom papers) must include an abstract that will appear after the title page and blank sheet. It is not mentioned in the table of contents. It must be limited to one page and must be single-spaced. The margins should be the same as for the body of the thesis, and the heading should follow the format shown in the sample abstract (see sample page C). An abstract is a capsule statement of the principal areas of investigation, main lines of argument, and chief conclusions of the thesis. It is a self-contained summary and not an evaluation or description of the thesis. An abstract should provide a quick glance at the contents and conclusions of the thesis. “Abstracts should not promise, predict or tantalize; they should deliver in sum what the essay pays out in full account. The preparation of a lucid abstract is the final test of an author’s control of his material” (Semeia 1 [1974]: 278).

The following information should appear single-spaced at the top of the abstract page: title of thesis, author, degree, date, advisers. The abstract should be arranged in paragraphs. The first paragraph should make clear the content of the passage and/or the nature of the problem involved. In general there should be no quotations in the abstract. Main lines of argument should be capsulized, but it is improper simply to list chapter titles or headings. The principal conclusions of the thesis must be crystal clear in the abstract.

Acceptance page. An acceptance page must follow the abstract in a Th.M. thesis only (see sample page D). The acceptance page includes:

- The following statement, centered and double spaced in sentence capitalization format, beginning 4 inches from the top edge of the page:

  Accepted by the Faculty of Detroit Baptist Theological Seminary
  in partial fulfillment of requirements for the degree
  Master of Theology

- A centered, 3-inch signature line for each adviser. The first line should appear 6 inches from the top edge of the page, and successive lines at 1-inch intervals for each adviser. The word Adviser should appear directly beneath each line.

Table of contents. The Th.M. thesis (not normal classroom papers) must include a table of contents. The first item listed in the table of contents should be the list of abbreviations. Bold and italic fonts are not used in the table of contents; different levels of subheadings are shown by indentation. Also note that decimal tabs must be used to align the periods after each chapter number, and a right tab to align the page numbers on the right margin. Take note of sample page E for assistance in these details.
List of abbreviations. Any thesis using abbreviations must include a list of all abbreviations used in the thesis (see sample page F), including those that appear on the approved list on pages 45–51 of this manual. Exceptions are books of the Bible and other common abbreviations (such as OT or NT) which will be readily understood by future readers. This list must conform to the approved list, except where there has been a need to formulate additional abbreviations. A more extensive list can be found in the *The SBL Handbook of Style*, edited by Patrick H. Alexander et al. (Hendrickson, 1999). See the discussion below on page 16 of this manual.

Other front matter. Do not include a dedication page, preface, or acknowledgements.

Body of text (See sample pages G–M).

*Normal classroom papers.* The title of the paper is the section heading for the body of the text. Place the title on the first page of text, two inches from the top edge of the page. The title should appear exactly as it does on the title page, except it should be single-spaced if more than one line is required. Leave two blank *single-spaced* lines between the title and the first line of text.

Seminary papers must be hierarchically organized under a specific protocol. This manual allows up to five levels: major headings and four subheadings. All headings are preceded by two blank *single-spaced* lines and followed by one blank *single-spaced* line. Major headings and the first two subheadings are centered and use headline capitalization style, that is, capitalize the initial letter of the first and last words and of all words except articles, prepositions of four letters or fewer, and coordinate conjunctions. Major headings appear in **bold font**, first level subheadings in *italics*, and second level subheadings in Roman font. Centered headings and subheadings exceeding five inches are subdivided into two *single-spaced* lines arranged in an inverted pyramid. Third and fourth level subheadings appear on the left margin and are capitalized in sentence capitalization style. Third level subheadings appear in *italics*, fourth level headings in Roman font. If all five heading levels are not used, several of them may be selected as long as they are used in descending order. It is not permissible to have two headings immediately following each other without some intervening text (except the introduction may directly follow the title). Also, a new section should not begin at the bottom of a page unless there is room for at least one line of text.

The text of the body is normally double-spaced. However, a *single-spaced* block quotation is to be used for quotations that are at least *four full lines* in length and *contain more than one sentence* (if the quotation is more than four lines, but not more than one sentence, it should not appear in block format). An exception to this rule is made for the discussion of specific Scripture texts, where the writer is encouraged to block a smaller section of text for discussion, immediately after a section heading, for the ready reference of the reader (i.e., the reader should not have to open additional resources in order to follow the discussion of the paper). Block quotations are indented on the left only, ¼ inch from the left margin (normal paragraphs are indented ½ inch). The right margin of block quotations should be the same as for the rest of the text (i.e., no indentation or right justification, and a margin of one inch to the edge of the paper). Block quotations are not set in quotation marks. Block quotations should never be preceded by a period but should have the same punctuation as if they were not block quotations. See examples on sample pages J, K, and M.
Th.M. theses. The body of the Th.M. thesis is formatted exactly like normal classroom papers with the following exception. Theses are organized in chapters, each chapter representing a separate section of the paper. As in all sections, the first page of each chapter must have the page number centered at the bottom of the page and a section header centered in ALL CAPS two inches from the top edge of the page. The section header includes the word CHAPTER, a chapter number in uppercase Roman numerals, and a chapter title in uppercase letters:

CHAPTER IV

THE DISCOVERY OF THE DEAD SEA SCROLLS

In Th.M. theses the thesis title does not appear on the first page of text. Chapter titles take the place of major headings in the hierarchy of headings of the Th.M. thesis, leaving four subheading levels for each chapter. Subheadings appear exactly as they do in classroom papers: first and second level subheadings centered in headline capitalization style, first level subheadings in italics and second level subheadings in Roman font; third and fourth level subheadings on the left margin in sentence capitalization style, third level subheadings in italics and fourth level headings in Roman font.

PART 5: PUNCTUATION, SPELLING, CAPITALIZATION, NUMBERS, AND ABBREVIATIONS

Spelling and punctuation. “Model your spelling on American usage and be consistent, except in quotations, where you should usually follow the original spelling exactly” (Turabian, p. 283)). It is the responsibility of the student to employ grammar and punctuation in strict conformity to proper, formal academic usage. Pay particular attention to frequently neglected rules regarding the use of commas, plurals, and possessives found in chapter 21 of Turabian. Proper use of diacritical marks is also expected (see the Formatting Your Paper page that follows this section).

Spacing and punctuation. Proportionally spaced fonts call for a spacing protocol different from typewritten, monospaced fonts. The following are some important differences the writer must observe when using proportionally spaced fonts:

- Leave only one space after terminal punctuation (periods, question marks, exclamation marks, quotation marks and superscripted footnote references).
- Leave no spaces before or after dashes or hyphens (see below).
- Leave no spaces before, in between, or after the dots of an ellipsis (see below).

A space follows all commas without exception. However, periods and colons lack a succeeding space:

- within Scripture references (e.g., Rom 3:10–12).
- between volume and page numbers (e.g., 2:136). Note, however, that there is a space if there is an intervening parenthesis (e.g., DBSJ 6 [2001]: 84).
- in classical references (e.g., Pliny Natural History 2.1.9). See Turabian 19.5.1.
• Between hours and minutes (e.g., 4:30 P.M.)
• in abbreviations of academic degrees (e.g., Ph.D.), and certain scholarly Latin abbreviations (see below, pp. 16–17). Note, however, that a space is left after periods following initials in a name (e.g., T. S. Eliot), and that two-letter state abbreviations and initials representing organizations (e.g., YMCA, GARBC) receive no period.

Use non-breaking or “sticky” spaces to prevent line breaks in Scripture references (e.g., 2 Corinthians).

**Punctuation and quotations.** Quotations never simply appear unannounced in the text, but are always introduced. Quotations are introduced in three ways:

- Quotations may appear **without punctuation or capitalization** as part of the flow of the sentence:

  Paul informs us that we can “know that in all things God works for the good of those who love him” (Rom 8:28).

- Quotations may be introduced **informally** (i.e., with the quotation functioning as the necessary object of an introductory verb) with an attendant **comma**. In this scenario the first word of the quotation is capitalized even if that word is not capitalized in the original:

  Paul says, “We know that in all things God works for the good of those who love him” (Rom 8:28).

- Quotations may be introduced **formally** (i.e., with the quotation functioning as an identification or example that validates an introductory and usually independent clause) with an attendant **colon**. In this scenario the first word of the quotation is likewise capitalized:

  In his epistles Paul expresses complete confidence in divine providence: “We know that in all things God works for the good of those who love him” (Rom 8:28).

**Note:** It is not necessary to include introductory conjunctions in order to maintain fidelity to the text of Scripture. E.g., it is not necessary to quote Romans 8:28 as “And we know that in all things God works for the good of those who love him,” unless, of course, attention is being drawn to the conjunctive element in the sentence.

When closing a quotation, place commas and periods **inside** closing quotation marks but semicolons and colons **outside** closing quotation marks. Question marks and exclamation points precede quotation marks if they are part of the quoted material but follow if they pertain to the entire sentence of which the quoted material is a part. This is considered proper “American” style. Some British and earlier American materials do not follow this pattern. In quoting such sources it is permissible either to change this matter of punctuation to conform to modern American style, or to copy the style of the original, as long as one **consistently** employs either pattern.

Always use “smart” quotation marks and apostrophes (‘,”’), not straight, or "dumb" ones (‘,’). This is a particular problem when importing electronic data directly into the term paper.
Hyphens and dashes. Pay careful attention to the proper use of hyphens and dashes.

- A hyphen (-) is used only in hyphenated words or to designate line breaks. Division of normally non-hyphenated words at the end of a line is discouraged. If word divisions are used, follow the rules in Turabian 3:35–53 explicitly.

- An en dash (—) with no preceding or succeeding spaces is used to indicate duration (e.g., January–March; pp. 10–20; Phil 2:5–11; 1994–98) and to produce compound words in which one of the terms employed is a hyphenated word (e.g., Neo-Babylonic–Persian conflict; Mid–Seventieth-Week Rapture).

- An em dash (—) with no preceding or succeeding spaces is the equivalent of a typewritten double hyphen, and is used to signal an abrupt syntactical shift in a sentence—one for which a comma is too weak, but a period is unnecessary.

Ellipses and Quotations. Contrary to Turabian and the SBL Handbook, this manual calls for the use of the ellipsis function-key offered in Microsoft Word and most other word processing programs. When the ellipsis is inserted without any adjoining punctuation, it appears with no spaces before or after. Whenever an ellipsis appears in connection with a period, a single space appears after the four dots, and a complete sentence must ensue. In the case of other punctuation (commas, semi-colons, colons, etc.) the placement of the punctuation relative to the ellipsis is determined by the relationship of the punctuation to the omitted material. For example,

- An ellipsis may stand for omitted material in the middle…of a sentence.

- An ellipsis may stand for omitted material that includes the end of the sentence, the beginning of another sentence, or both…. In this case, four dots and a space appear, and the ensuing material must be a complete sentence.

- An ellipsis may occur with a punctuation mark other than a period, in which case it may appear with the punctuation mark before the ellipsis,…or after the ellipsis…, with the determining factor being the relationship of the omitted material to the punctuation mark.

Ellipses are used only within a proximate context (i.e., an ellipsis cannot stand for multiple paragraphs or pages of omitted material). Ellipses are never used to open a quotation, even when the quoted material is drawn from the middle of a sentence in the original source.

Parentheses and brackets. Parentheses are used to enclose minor explanatory and interruptive elements in a sentence (e.g., i.e., etc.) and also to enclose Scripture references. Final punctuation normally follows parentheses, except in rare instances when a complete sentence is parenthetical. Parentheses also function as the only acceptable way to enumerate a list within a paragraph: (1) enumerated point one and (2) enumerated point two. Note that a non-breaking (“sticky”) space should be used to prevent an enumeration from standing alone at the end of a line. Contrary to the usage in this manual, bulleted points are not to be used.

Brackets are used to “enclose interpolations [e.g., explanatory remarks or the Latin word sic] in a quotation” (Turabian 3.99). Use [sic] to mark factual errors and misspellings and not for archaic language, alternate spellings, or poor grammar and punctuation. Note that the word sic is italicized, but not the brackets themselves.
Since brackets are also used to enclose a second layer of parenthetical material within parentheses, both parentheses and brackets commonly appear together in content footnotes. This is a proper and acceptable practice. Note the following:

**Incorrect:**

**Incorrect:**

**Correct**

**Better**

**Capitalization.** Use lower case pronouns when referring to persons of the Trinity (as in the KJV and NIV). For the capitalization of commonly used religious terms, see pages 52–60 of this manual.

**Use of numbers in text.** Excepting circumstances when cumbersome series of numbers are used, seminary papers should use non-scientific enumeration. To use this convention “spell out numbers from one through one hundred. If the number has two words, use a hyphen (fifty-five). Also spell out round numbers followed by *hundred*, *thousand*, *hundred thousand*, *million*, and so on. For all other numbers, use Arabic numerals” (Turabian 23.1.1). The same rule applies to ordinals. When writing ordinals, use the following *non-superscripted* suffixes: 121st, 122nd, 123rd, and so on. Numbers greater than one thousand receive a comma, except in years, page numbers, and addresses. Numbers are properly rendered plural with *s* not ‘s (*Incorrect: 1960’s; Correct: 1960s*).

Use numerals when referring to dates and time (8:30 A.M., the year A.D. 1519), page numbers, Scripture references, and parts of written works (*Pliny Natural History* 2.1.9). Note that Roman numerals are *not* used to reference volumes, parts, and chapters of printed works, but *are* used to reference popes, kings, or different generations of family members with the same name (e.g., Bob Jones III or Henry VIII).

Both the American style of writing dates (December 3, 1971) and the British style (3 December 1971) are acceptable, but use one style consistently. Never begin a sentence with a numeral.

For numerical sequences follow the table in Turabian 23.2.4:
### Abbreviations

Common abbreviations such as academic degrees, A.M. and P.M., B.C. and A.D., OT, NT, LXX, etc., may be used without explanation in the text or notes of seminary papers. Scholarly abbreviations such as those listed on pages 19–20 of this manual may be used without explanation in footnotes and parenthetical remarks only. Works found in the approved list of abbreviations appended to this manual may be abbreviated in the all footnotes (including the first) without explanation. If a work cited numerous times in a paper is not found in the list of approved abbreviations, the writer may formulate an abbreviation in the first full reference, borrowing, if possible, from authoritative lists such as the *SBL Handbook of Style*, pp. 89–152, or the “*Journal of the Evangelical Theological Society* Instructions for Contributors,” *JETS* 44 (2001): 153–77. For example:

4. *RG*, p. 918.

Do not use abbreviations of names or titles in the bibliography.

Abbreviate the names of the books of the Bible when used parenthetically, but never abbreviate in the text. The abbreviations should conform to the list of abbreviations on page 42 of this manual. Bible quotations should not be footnoted. Instead, where the reference is not included in the discussion, it should follow the quotation in parentheses (Gen 1:1). This reference for documentation is a part of the sentence and should not be preceded by a period. A colon should be used between the chapter and verse divisions of a biblical reference. Note that, contrary to Turabian, no period is used after the book abbreviation. Commas are used between several references to the same level, a semicolon between references to different levels, and an en-dash between continued numbers:

1 Thess 4:4, 8  
1 Thess 4:4; 5:3  
1 Thess 4:4–6


Formatting Your Paper in Microsoft Word XP/2003: How to Do It

Tabs

To align decimal points for chapter titles in a table of contents:

- Click on the Format drop-down menu.
- Choose Tabs.
- Under Tab Stop Position select a distance that will accommodate the physically longest Roman numeral you will use (0.2” will accommodate I–VI; 0.3” up to XVI.)
- Under Alignment select Decimal.
- Click Set.
- Click OK.

To create a right tab aligning page numbers in a table of contents:

- Click on the Format drop-down menu.
- Choose Tabs.
- Under Tab Stop Position select 6” (the right margin for a Th.M. thesis).
- Under Alignment select Right.
- Under Leader select 2.....
- Click Set.
- Click OK.

Note: The same results can be achieved using the Ruler feature. To use the ruler, click on the View drop-down menu and select Ruler.

Autoformatting Options

Click on the Tools drop-down menu.
Choose AutoCorrect.
Select the AutoFormat As You Type tab.
Under “Replace”:
- check the box Straight Quotes with Smart Quotes.
- check the box Fractions (1/2) with fraction character (½).
- uncheck the box Ordinals (1st) with superscript.
- uncheck the box Internet and network paths with hyperlinks.
- Click OK.

Note: to make corrections for fractions and quotation marks after the fact, follow this procedure, then use the find and replace feature to make the corrections:

- Click on the Edit drop-down menu.
- Choose Replace.
- Key in a quotation mark, apostrophe, or fraction in both the find what and replace with text boxes.
- Click Replace All.
- Click OK.

(Word will overwrite all the incorrect symbols with correctly formatted symbols.)

Undoing incorrectly formatted ordinals and hyperlinks must be accomplished manually, one at a time.

Common Diacritical Marks

- Ctrl+ ’ followed by a vowel → é
- Ctrl+` followed by a vowel → è
- Ctrl+ ~ followed by a consonant → ñ
- Ctrl+, followed by a consonant → ç
- Ctrl+/ followed by a vowel → ø
- Ctrl+: followed by a vowel → ö
- Ctrl+ ^ followed by a vowel → å
- Ctrl+ @ followed by a vowel → â
- Ctrl+ & followed by “a” or “o” → æ or œ

Dashes

- Ctrl+ - (numerical keypad) → en dash
- Alt+Ctrl+ - (numerical keypad) → em dash

Non-breaking Space

- Ctrl+Shift+Space → non-breaking space.
Formatting Your Paper in Microsoft Word 2007: How to Do It

Tabs
To align decimal points for chapter titles in a table of contents (Th.M. thesis):
Click on the Page Layout tab.
Open the Paragraph dialog box launcher.
Select the Indents and Spacing tab.
Click on the Tabs box.*
Under Tab Stop Position select a distance that will accommodate the physically longest Roman numeral you will use (0.2” will accommodate I–VI.; 0.3” up to XVI.)
Under Alignment select Decimal.
Click Set.
Click OK.

To create a right tab aligning page numbers in a table of contents:
Click on the Page Layout tab.
Open the Paragraph dialog box launcher.
Select the Indents and Spacing tab.
Click on the Tabs box.
Under Tab Stop Position select 6” (the right margin for a Th.M. thesis).
Under Alignment select Right.
Under Leader select 2......
Click Set.
Click OK.

*The tabs settings may be accessed more quickly by double-clicking anywhere on the ruler. To use the ruler, click on the View tab, find the Show/Hide box, and check the box for Ruler.

Autoformatting Options
Click on the Microsoft Office button
Click on Word Options.
Click on Proofing.
Click on Autocorrect Options.
Select the AutoFormat As You Type tab.
Under Replace:
check the box Straight Quotes with Smart Quotes.
check the box Fractions (1/2) with fraction character (½).
uncheck the box Ordinals (1st) with superscript.

uncheck the box Internet and network paths with hyperlinks.
Click OK.

Note: to make corrections for fractions, apostrophes, and quotation marks after the fact, follow this procedure, then use the find/replace feature to make the corrections:
Click on the Home drop-down menu.
In the Editing box click on Replace.
Key in a fraction, apostrophe, or quotation mark in both the find what and replace with text boxes.
Click Replace All, a command that orders Word to overwrite all the incorrect symbols with corrected ones.
Click OK.

Undoing incorrectly formatted ordinals and hyperlinks must be accomplished manually, one at a time, so be careful to change the autocorrect options before starting a paper.

Crafting Common Diacritical Marks
Ctrl ‘ followed by a vowel → é
Ctrl ` followed by a vowel → è
Ctrl ~ followed by a consonant → ñ
Ctrl , followed by a consonant → ç
Ctrl / followed by a vowel → ø
Ctrl : followed by a vowel → ō
Ctrl ^ followed by a vowel → â
Ctrl @ followed by a vowel → å
Ctrl & followed by “a” or “o” → æ or œ

Dashes
Ctrl/- (on numerical keypad) → en dash
Alt/Ctrl/- (on numerical keypad) → em dash

Non-breaking, “Sticky” Space
Ctrl/Shift/Space → non-breaking space

Ellipses
Ctrl/Alt/. (on standard keyboard) → ellipsis
PART 6: FOOTNOTE AND BIBLIOGRAPHIC ENTRIES

The instructions in this section give guidelines for citing materials in research papers. These instructions are not exhaustive, but cover most types of works and note modifications from Turabian. If these instructions do not address a specific citation issue, consult Turabian. If Turabian does not address the issue, consult The Chicago Manual of Style (15th ed.).

Make reference entries as complete as possible. References are designed to point the reader to exact sources, so diligence should be exercised in this matter. If bibliographic data is not readily accessible in the standard locations yet can be definitely established elsewhere, it should be included, in brackets, in the entry. The detail involved in crafting footnotes is sometimes onerous; however, as Turabian notes, “If you do not get these small matters right, many of your readers will question whether they can trust you on the big ones” (Turabian 15.2.2).

Appearance of footnotes. All research papers and theses submitted to Detroit Baptist Seminary must use footnotes, not endnotes or parenthetical references. There are four types of footnotes that appear in scholarly writing, and students should learn to use all four: (1) citation footnotes that identify an authority referenced, (2) cross references within the paper, (3) content footnotes that make incidental comments that fill out the discussion but which would interrupt the flow of the argument if included within the text, and (4) acknowledgments.

Footnotes appear in the same font style used in the rest of the paper, but should appear in 10-point font. Footnotes are separated from the text by a two-inch separator line and a single space. Each note is indented ½ inch, begins with a superscripted Arabic note number, and commences immediately after the note number with no intervening space. Footnotes are single-spaced with a single blank line separating each note. The component parts of footnotes are separated with commas or parentheses.

Footnote numbering runs continuously throughout the entire paper or thesis. Do not begin each page or each chapter with footnote “1.” Footnotes must begin on the same page on which the reference number appears in the text, but may continue on the next page. When a note continues to the next page, however, make sure that the break is in mid-sentence so that the reader does not mistakenly overlook the material on the next page. Do not use footnotes in section headings. Footnotes normally fall at the close of sentences or clauses, not after words or phrases within a single thought. Never place two footnotes together at the same point in your paper and avoid clusters of footnotes. Instead, combine thoughts into a single footnote.

Abbreviations. Unlike the text of the research paper, footnotes make liberal use of accepted scholarly abbreviations when possible. The following is a list of common Latin terms and abbreviations that are to be used in footnotes:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>b.</td>
<td>→ born</td>
</tr>
<tr>
<td>ca.</td>
<td>→ circa = approximately</td>
</tr>
<tr>
<td>cf.</td>
<td>→ confer = compare (do not confuse with “see”)</td>
</tr>
<tr>
<td>chap.</td>
<td>→ chapter</td>
</tr>
<tr>
<td>col.</td>
<td>→ column</td>
</tr>
<tr>
<td>comp.</td>
<td>→ compiler; complied by</td>
</tr>
<tr>
<td>contra</td>
<td>→ against; as opposed to</td>
</tr>
<tr>
<td>d.</td>
<td>→ died</td>
</tr>
<tr>
<td>ed.</td>
<td>→ editor; edition; edited by</td>
</tr>
<tr>
<td>e.g.</td>
<td>→ exempli gratia = for example (do not confuse with i.e.)</td>
</tr>
<tr>
<td>esp.</td>
<td>→ especially</td>
</tr>
<tr>
<td>et al.</td>
<td>→ et alii = and others (as individuals)</td>
</tr>
<tr>
<td>etc.</td>
<td>→ et cetera = and so forth</td>
</tr>
<tr>
<td>et alia</td>
<td>→ et alia = and others (as things)</td>
</tr>
</tbody>
</table>

Note: The use of abbreviations should be limited to those that are commonly recognized by the reader.
In footnotes use the approved abbreviations for the books of the Bible, periodicals, reference works, and serials found on pages 42–51 of this manual. Works found in the approved list of abbreviations may be abbreviated in the first footnote. For works not found in the list of approved abbreviations, the writer may formulate an abbreviation in the first full reference:


Subsequent and shortened references. After a work has been cited in full, it is not necessary to make a complete citation for subsequent references. While abbreviations such as op. cit., and loc. cit. have fallen into disfavor, the following truncations are acceptable and expected:

- When reference is made to the same work as in the immediately preceding reference, use ibid. to replace the author’s name, title, and as much of the succeeding material (including page numbers) as is identical to the previous note. Ibid. is not italicized, always appears with a period (as an abbreviation for ibidem), and is capitalized when it begins a note. Note that ibid. refers to the exact work as in the previous note, not just the same author. Never use ibid. after a note containing two or more references.


2. Ibid. [for a citation from the same page in the same source]

3. Ibid., p. 156. [for a citation from a different page in the same source]
• When reference is made to a work with the same author as the immediately preceding reference or within a note to a second work by the same author, use idem to replace the author’s name only. Like ibid., idem is not italicized and is capitalized at the beginning of a note. Since it is a complete word, however, it is not followed by a period. As with ibid., never use idem after a note containing two or more references or if authors are added to or omitted from the previous reference.


but


• When referencing a work that has already been cited in full, but not in the immediately preceding note, a shortened reference should be used. For shortened references use the last name of the author(s), followed by a shortened title, then by pages referenced. Shorten the title by omitting the subtitle, initial article, and modifying words and phrases. Avoid one-word shortened references, except with commentaries. See the examples of subsequent references in the subsections below.

Appearance of bibliographic entries. See sample page N. The bibliography, as defined in this manual, is a comprehensive list of all sources consulted with profit in the course of research. However, it is entitled simply “Bibliography.” The entries appear in alphabetical order in a single list. Do not separate the bibliography into classifications such as “Books” and “Articles” or “Primary Sources” and “Secondary Sources.” Note that major sacred texts such as the Bible (whether in English or in the original languages) or Koran are not included in the bibliography (Turabian 16.2.3).

The first line of each bibliographic entry is flush with the left margin of the page, and all successive lines are indented ½ inch. The bibliography is single-spaced with a single blank line separating entries. Unlike footnotes, which separate component parts with commas or parentheses, bibliographies usually separate component parts with periods.

Do not use abbreviations of names or titles in the bibliography. Spell out any abbreviations that follow a period in a bibliographic entry (e.g., “Edited by,” “Translated by,” “Revised ed.”) with the exception of “s.v.” in separately signed articles of standard reference works. In successive entries for works by the same author, however, the author’s name in subsequent entries may be replaced with a ½-inch line. Do not use this line if authors are added or omitted in subsequent references.


but

Books

The following is a list of component parts of a book reference. The sequence of these parts should be maintained at all times, even though every component will not appear in a given note. (For example, a book may have no editor and belong to no series.) In this case, simply skip these parts and go on to the next. But do not tamper with this sequence.

- Name of author(s)
- Title and pertinent subtitle
- Name of editor, compiler, or translator
- Number or name of the edition if other than the first
- Name of series in which book appears, including volume or number in the series
- Facts of publication, including (1) the place of publication, (2) the name of the publisher or publishing agency, and (3) the date of publication
- Page number(s) of a specific citation (footnote entries only)

Name of author(s). In footnotes, authors’ names are given in normal order (First M. Last). The names should appear as they do on the title page, but full middle names may be reduced to a middle initial. Do not include professional or ministerial titles (e.g., Doctor, Reverend) or degrees conferred. Books with two or three authors should list all the authors, but books with four or more authors should list the first author followed by “et al.”

FN:

In bibliographies, the first author’s name is given in inverse order (Last, First M.), with successive names in normal order (First M. Last). Unlike footnotes, bibliographies list the names of all authors, even when there are four or more.


If a writer wishes to reference an edited book as a whole, it is acceptable to cite the editor of the work in the manner given above with the addition of a comma and ed(s). Usually, however, a writer will not reference an edited book as a whole, but an essay in the book (see below).

FN:
2 Willis and Master, *Issues in Dispensationalism*.


If authorship or pseudonymity has been definitely attested but does not appear on the title or copyright page, the information should be included in brackets in references. If authorship cannot be attested, the entry may begin with the title. Note the following:
\[\text{[Richard Cox], An Inquiry into Religion and the Use of Reason in Reference to It…}\]

\[\text{John Woodmorappe [pseud.], Noah’s Ark: A Feasibility Study…}\]

\[\text{Isaac Skillman [John Allen?], An American Alarm, or, The Bostonian Plea for the Rights, and Liberties, of the People…}\]

\[\text{A Narrative of the General Assembly in London, 1689…}\]

In cases where the author’s name is part of the title, omit the author’s name in a footnote, but retain it in bibliographies, despite the redundancy.


\[\text{\textit{but}}\]


\textit{Title and pertinent subtitle. In both footnotes and bibliographies the title appears \textit{in italics} in headline capitalization form. Original spelling and punctuation should be maintained from the title page, except that a colon may be assumed between a title and subtitle even if one does not appear on the title page. Do not add a comma or colon if a title or subtitle ends with terminal punctuation (e.g., a question mark or exclamation point). Contrary to Turabian, the subtitle of a book should be included in references only when the subtitle aids the reader in identifying more accurately the nature of the work cited.}\]

FN: \[\text{\textsuperscript{1}Peter T. O’Brien, The Epistle to the Philippians, NIGTC (Grand Rapids: Eerdmans, 1991), p. 213.}\]

\[\text{\textsuperscript{2}O’Brien, Philippians, p. 215.}\]


\[\text{[Omit the superfluous subtitle A Commentary on the Greek Text.]}\]

\[\text{\textit{but}}\]

FN: \[\text{\textsuperscript{1}Homer A. Kent, The Freedom of God’s Sons: Studies in Galatians (Grand Rapids: Baker, 1976), p. 34.}\]

\[\text{\textsuperscript{2}Kent, Freedom of God’s Sons, p. 56.}\]


\[\text{[Here the subtitle is necessary to identify this work as a commentary on Galatians.]}\]

\textit{Name of editor, compiler, or translator. In footnotes, the names of editors, compilers, or translators appear in normal order (First M. Last) in the order they appear on the title page, preceded by the appropriate abbreviations ed., comp., or trans. Note that in this case \textit{ed}. is not plural because it stands for \textit{edited by}, not \textit{editor} or \textit{edition}. Each phrase is set off by commas.\]
In bibliographies the names also appear in normal order, but are preceded by the full, unabbreviated phrases *Edited by*, *Compiled by*, or *Translated by*. Each phrase is set off by periods.

**FN:**


Contrary to Turabian, the name of the author of a preface, forward, or introduction should not be included unless citing or specifically referencing the preface, etc., in which case cite as follows:

**FN:**


2 Van Til, introduction to *Inspiration and Authority*, p. 58.


Number or name of the edition if other than the first. In both footnotes and bibliography entries new, revised, numbered, or named editions must be noted. (Reprint editions are also noted, but this information appears with the fact of publication—see below.) Abbreviations should be used in footnotes, but an abbreviation should be spelled out in a bibliography entry when it follows a period (examples 1, 4, and 5), or when it is parallel to a non-abbreviated term (e.g., *enlarged* in example 5).

<table>
<thead>
<tr>
<th>Footnote</th>
<th>Bibliography</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd ed.</td>
<td>2nd ed.</td>
</tr>
<tr>
<td>rev. ed. in 1 vol.</td>
<td>Revised ed. in 1 vol.</td>
</tr>
<tr>
<td>rev. and enl. ed.</td>
<td>Revised and enlarged ed.</td>
</tr>
</tbody>
</table>

New editions may also have new editors, which should be noted:

**FN:**


Name of series in which book appears, including volume or number in the series. Some books are published as part of a named series. These must not be confused with multivolume works or periodicals. A multivolume set has a single title (though individual volumes may also have independent titles), deals with a single subject, has a single editor or group of editors, and has a more or less defined number of volumes from the outset of the project. Periodicals are published at fixed intervals, are open-ended, generally have a broader scope of subjects, and each issue contains multiple signed articles. A series is an ongoing publication series with a common sponsor (usually a publisher, institution, or university), has an erratic publication schedule, and has a rather wide range of topics that appear individually as whole books.

In both footnotes and bibliographies, series information appears in Roman (not italicized) font just before the facts of publication, and includes volume number and series editorship exactly as they appear on the title page. Series abbreviations may be used in footnotes, but not in bibliographic entries.

FN:  
2Wills, Democratic Religion, pp. 23–29.

B:  

FN:  
2Bock, Proclamation from Prophecy and Pattern, p. 47.

B:  

Most commentary sets do not fit into any clearly defined category. They have characteristics of both series and multivolume works (see below). Use the examples below to formulate references for commentaries. Note that names of commentary sets (e.g., NICNT, ICC, AB, TN TC) are not italicized. Note also that volume numbers and series editors are omitted.

FN:  
2Brooke, Johannine Epistles, pp. 77–79.

B:  

FN:  
2Dibelius and Conzelmann, Pastoral Epistles, p. 48.

B:  
FN:  
2Lane, *Mark*, pp. 49–51.

B:  

FN:  

B:  

*Facts of publication.* The facts of publication include (1) the place of publication, (2) the names of the publisher or publishing agency, and (3) the date of publication. *In footnotes* the facts of publication are enclosed in parentheses with no preceding punctuation and an ensuing comma. *In a bibliography entry* parentheses are omitted and a period follows the publication information.

When giving the city of publication, give the city provided on the title page. If two cities are given, choose the first U.S. city listed. If there is no U.S. city listed, choose the first English-speaking city listed. If there are no English-speaking cities listed, choose the first city mentioned, giving the English name for a foreign city (e.g., Munich, not München). If the city is not well known or might otherwise be confused with another (e.g., Cambridge), include a comma and the two-letter postal code abbreviation with the city. *In both footnotes and bibliography entries* the place of publication is followed by a colon, a space, and then the publisher. If no city is given, but the city may be definitely established, include the city name in brackets. Otherwise use the abbreviation *n.p.* (no place).

Normally the name of the publisher should be given in full. However, the initial “The,” the abbreviations “Co.,” “Inc.,” or “Ltd.,” and certain words like *Press* and *Publishing House* are omitted. Note, however, that university presses retain the word *press*. “Brothers” should be abbreviated as “Bros.” A listing of shortened names for select publishing firms is included on pages 36–37 of this manual. If no publisher is listed use the abbreviation *n.p.* (no publisher). If there is neither city nor publisher listed, a single *n.p.* is sufficient.

The date of publication is the *latest copyright date* on the verso of the title page. Do not confuse this with the latest printing or impression date. If no date is given, but the date may be definitely established, include it in brackets. Otherwise use the abbreviation *n.d.* (no date). If a book has been accepted for publication but is not yet published, supply the word *forthcoming*.

*Page number (footnotes only).* If a footnote refers to a book as a whole, page numbers are omitted. Otherwise, the specific page number(s) of the reference are listed preceded by a comma, a space, and p. (single page) or pp. (multiple pages). Use of f. and ff. is no longer acceptable in formal writing.
Examples:

<table>
<thead>
<tr>
<th>Footnote</th>
<th>Bibliography Entry</th>
</tr>
</thead>
</table>

Reprint Editions: When an original publisher reprints a book without changes or in paperback, this is not considered a reprint edition by this manual. In such cases the reprint date is ignored—the latest copyright date is the one reported. In order to be considered a reprint edition, a publication must be reproduced by a different publisher and/or with changes in formatting/pagination. In such cases, include all of the publication data for the reprint and for the original publication, if indicated.


²Carson, *Divine Sovereignty and Human Responsibility*, p. 244.


Multivolume Works

See above for the difference between multivolume works, series, and periodicals. Entries for multivolume sets differ from entries for books in as many as three areas: (1) specific volume information, (2) date, and (3) page references.

Multivolume works with a single author and title. Include the total number of volumes in Arabic numerals just before the facts of publication. If a set is incomplete use the form 3 vols. to date.

Include the dates of publication for the entire set. In a two-volume work with different copyright dates, each date should be listed separately. In a work of three or more volumes, the dates can be listed separately (e.g., 1957, 1964, 1971) or a duration of dates may be indicated (e.g., 1957–71). If a multivolume work is incomplete, the date should be left open (e.g., 1998–).

For page numbers, do not use p. or pp. Instead, indicate the page cited by using the volume number followed by a colon, no space, and the specific page number (2:136).

          ²Lewis and Demarest, *Integrative Theology*, 1:292.


*Multivolume works with a single general title and different volume titles by a single author.* In this instance include (1) the specific volume title, followed by (2) *in*, then (3) the multi-volume title. If a single physical volume is in view, use the date of that volume and not of the entire set. Since a single volume is in view, revert to page numbers preceded by *p.* or *pp.*


If, however, more that one physical volume is in view, use the following:


*Multivolume works with a general title and editor and individually authored or edited volumes each with its own title.* Follow the protocol above, but include specific editing information as follows:


Journal Articles

The following is a list of component parts of a journal article reference. The sequence of these parts should be maintained at all times.

- Name of author(s)
- Title of article
- Title of journal
- Volume number
- Publication date
- Page number(s)

Name of author(s). For both footnotes and bibliographic entries, cite authors of journal articles in the same way as authors of books.

Title of article. For both footnotes and bibliographic entries, enclose the title in quotation marks in headline capitalization style. Do not use italics for article titles.

Title of Journal. For both footnotes and bibliographic entries, the journal title should be italicized and should appear in headline capitalization style. Do not use quotation marks for journal titles. For footnotes, use abbreviations for journal titles from the approved list on pages 45–51 of this manual. If a specific journal title does not appear on this list, an abbreviation may be formulated in the manner described on page 17 of this manual. For bibliographic entries, spell out journal titles in full.

[Note: for the Th.M. thesis all abbreviations used must appear in the List of Abbreviations.]

Volume number. Immediately following the journal title with no intervening punctuation the volume or issue number should appear in Arabic numerals. When a journal has both a volume and issue number, it is necessary to include only the volume number. If a journal has only an issue number, however, use the issue number preceded by the abbreviation no.

Publication Date. The date of publication follows the volume number and is enclosed in parentheses. Contrary to Turabian, always include the month or season as it appears on the journal title page or issue cover.

Page numbers. In footnotes, the specific page(s) referenced follows the publication date and a colon. In initial entries, the abbreviations p. and pp. are not used. Note, however, the change in subsequent references. In bibliographic entries inclusive pages for the whole article follow the publication date.


Component Part of a Book or Volume

Volumes of collected essays or short books present new elements for the writer. Citation of these component parts combines elements from the citation styles for both books and periodicals. Note the following sequence: (1) the author of the component essay or book, followed by (2) the essay title enclosed in quotation marks or book title in italics). This is followed by (3) the word in and the title of the collected work, and (4) the name of the editor (if applicable). The rest of the reference (series titles, publication data, page numbers) follows exactly like a book. Note the following examples:

Essay in an edited collection of essays:

FN:  

B:  

Essay in a non-edited collection of essays:

FN:  

B:  
Essay in a multi-volume collection of essays:


Alternatively, when it is preferable to note the exact date of an essay in a multi-volume collection, cite as follows:


2Carson, “Matthew,” p. 78.


Originally full-length book bound together with other materials in a single volume:


2Edwards, Life and Diary of Brainerd, p. 265.


Articles in Encyclopedias, Dictionaries, and Lexicons

Unsigned Articles: If an article is unsigned, provide full citation for material cited from an encyclopedia, dictionary, or lexicon. Footnotes referencing works with approved abbreviations (pp. 45–51 of this manual) include only the abbreviation and (contra Turabian) a page number. The bibliography, however, should contain full bibliographic information. Note the following:

FN: 1BDB, p. 182. [There is no shortened reference for this entry.]


FN: 1BDAG, p. 588. [There is no shortened reference for this entry.]

Signed Articles. Signed articles in well-known reference works need not be cited in full in either footnotes or bibliographic entries. They must, however, include the title of the reference source, edition (if other than the first), the author of the article, a sub verbo notation, and a page number. As is normally the case, approved abbreviations are adequate in footnotes, but not in bibliography entries. Note the following:

**FN:**


**FN:**


**FN:**


**FN:**


Miscellaneous Footnote and Bibliographic Forms for Printed Sources

Magazine Articles. Magazines such as Christianity Today and Modern Reformation that publish at least twelve issues a year fit into Turabian’s category of “magazines of general interest” (15.231). Magazine citations resemble journal citations, but the date takes the place of the volume number, is preceded by a comma, and is not enclosed in parentheses. Note the following:


Note: For articles that begin in the front of a magazine then skip to the back, inclusive page numbers are meaningless. In this situation include only the first page of the article in a bibliographic entry.

Book Review.


Theses and Dissertations.


²Combs, “Blasphemy Against the Holy Spirit,” p. 120.

Seminar and Society Papers.

FN:  


FN:  
1Bruce A. Ware, “Male Priority in Man and Woman as the Images of God” (paper presented at the 52nd annual meeting of the Evangelical Theological Society, Nashville, TN, 16 November 2000), pp. 4–5.

2Ware, “Male Priority,” p. 8.


Class Notes.

FN:  
1Rolland D. McCune, “Systematic Theology II” (class notes, Detroit Baptist Theological Seminary, Fall 2001), p. 58.


B: McCune, Rolland D. “Systematic Theology II.” Class notes, Detroit Baptist Theological Seminary, Fall 2001.

Classical References. Classical reference form is commonly used for classical and medieval literature, but is not limited thereto. The criterion for using classical reference form is not antiquity, but the organization of the text into recognized divisions that are independent of pagination in multiple critical editions and translations. In this form it is standard to omit facts of publication in footnote references unless it one is citing the precise wording of a particular edition or translation. The overuse of abbreviations in classical reference form is discouraged. The rule of thumb is to give as much information as is necessary for the reader to relocate the source. Note the following:

FN:  
1Irenaeus Against Heresies 3.18.7, in ANF, 1:448.

2Irenaeus Against Heresies 4.9.2.

FN:  

2Augustine Confessions 12.23.


FN:  

2Calvin Institutes 1.13.3.


Secondary Source of Quotation.

FN:  


Documentation of Electronic Sources

Electronic sources present the writer with several significant complications that are not easily remedied by referencing guidelines. First, electronic sources are transient. URLs and ISPs tend to change on a daily basis, and a document available today may be gone tomorrow. Further, rapid changes in data storage can render data inaccessible. Second, electronic sources are prone to frequent, undocumented revision. Third, most electronic sources are not paginated, making relocating material a frustrating task. Read these general guidelines carefully, then follow the examples provided to give as full and accurate a reference as is possible.

General Guidelines.

- Always refer to print sources if they are available. This relieves the problems of transience, pagination, and poor scanning techniques common to electronic sources.
- If an electronic document is a reproduction of a print source that is not available to you, include as much information about the original print source as is available.
- If authorship of an electronic source cannot be definitely established, the student is strongly encouraged not to use the source. A website is not an authority, and is essentially an anonymous source apart from clear authorship.
• Citation of articles that do not have fixed page numbers or paragraph numbers should identify the location of the cited material by chapter titles or section headings preceded by the word under.

• Indicate the type of source being referenced with a URL, or the designation “microfiche,” “CD-ROM,” etc.

• Internet citations should include a date accessed after the site address.

• Since electronic sources tend to be transient, download a copy of the electronic source to a disk or make a hard copy for future reference.

• When citing an URL address, turn off the hyperlink function on your word processor. URL addresses should appear in black font without underlining. If it is necessary to break a URL address to fit on a line, break the address at a slash (/) in the address.

Formally Published Electronic Sources. Some electronic sources differ from their print counterparts in nothing other than their media. These include formally published journals, e-books, and databases that appear online or on physical media such as microform, CD-ROMs, and DVDs. Cite these just as print books and articles, but add information to direct the reader to the electronic version used.

Electronic journal article online:


CD-ROM source:


²Van Til, Paul at Athens, under “The Frame of Reference.”

Microform source:

FN:  


Article from Electronic Database:

FN:  


Informally Published Electronic Sources.

Signed, dated article on the World Wide Web:

FN:  


Unsigned, undated article on the World Wide Web (author is site owner):

FN:  

Weblog Entry or Comment.


²Dever, “Dever Doesn’t Practice Separation?”


²[Doran], comment on “Dever Doesn’t Practice Separation?”

Formatting Your Paper in Microsoft Word XP/2003: How to Do It

Inserting Footnotes
Place your cursor at the point in your text where you want a footnote.
Under the Insert drop-down menu select Footnote.
Select Options.
Under Place at select bottom of page.
Under Numbering select Continuous (In the Th.M. thesis this allows the writer to write the entire thesis in a single document, each chapter a successive section with continuous footnotes).
Click OK.

Note: Once the initial footnote is inserted, successive footnotes can be added simply by keying Control/Alt F.

Formatting Footnotes
Under the View drop-down menu, select Normal. (Some of these instructions will work only in this view.)
To create proper separator lines:
Click on the View drop-down menu.
Select Footnotes.
In the new footnote box select Footnote Separator.
Key in a 2” line and hit enter, inserting a single blank line.
Highlight the line and space you just made and copy it (Control+ C)
Select Footnote Continuation Separator.
Delete the default line.
Paste (Control+ P) the 2” line and space from your buffer.

Note: to avoid indenting and spacing each note individually and to create notes in your preferred font size, create a style for footnote text.

Eliminating Gaps and Footnotes that Appear on the Wrong Page

Turn off Orphan/Widow Control:
Under the Format drop-down menu, select Paragraph.
Click the Line and Page Breaks tab.
Uncheck Widow/Orphan Control.
Repeat these procedures for paragraphs within footnotes.

Note: This procedure will affect only a highlighted area or the paragraph in which the cursor is located. It is best to set paragraph style before writing. If you don’t, highlight the entire paper before following these steps.

Use Printer Metrics:
Under the Tools drop-down menu, select Options.
Click on the Compatibility tab.
Scroll down to Use printer metrics to lay out document and check the box.

Note: This procedure works only with Macintosh and older versions of Word. On other versions unchecking this box will improve the format.

Rework the Paragraph: In some cases the only solution is to rewrite sentences or consolidate a cluster of footnotes to eliminate unsightly gaps and footnotes that are forced to the next page.
Inserting Footnotes
Place your cursor at the point in your text where you want a footnote. Click on the References tab. In the Footnotes box click Insert Footnote.

Note: For a quicker way of doing this, simply key Control/Alt/F.

Formatting Footnotes
Appearance:
Click on the References tab. Open the Footnotes dialog box launcher. Under Location select bottom of page. Under Numbering select Continuous (In the Th.M. thesis this allows the writer to write the entire thesis in a single document, each chapter a successive section with continuous footnotes). Click Apply.

Footnote Separator:
Click on the View tab. Under Document Views select Draft (the instructions below will work only in this view.) Click on the References tab. Under Footnotes select Show Notes In Footnotes ribbon that appears at the bottom of the page select Footnote Separator. Key in a 2” line (default). Highlight the line you just made and copy it (Control/C). In Footnotes ribbon that appears at the bottom of the page select Footnote Continuation Separator. Delete the default line. Paste (Control/P) the 2” line from your buffer.

Indentation, Spacing, and Fonts
Avoid having to change indentation, font style, and spacing for each note by modifying the normal footnote style:
Right click on any footnote. From the popup menu select Style.
The footnote text style will be highlighted. Select Modify. Set font style to Times New Roman and font size to 10. At the bottom of the popup screen select Format. In the popup screen that appears select Paragraph. Click on Indents and Spacing. Under Indentation select the following: Special: First Line. By: 0.5” Under Spacing select the following: After: 6 pts. Line Spacing: Single
Click on Line and Page Breaks Uncheck the box marked Widow/Orphan Control. Click OK. In the Modify Style Screen click OK. In the Style screen click Apply.

Note: It is impossible to set the style to eliminate the space that appears after the note number. This must be done manually for each note.

Eliminating Gaps and Footnotes that Appear on the Wrong Page
Turn off Orphan/Widow Control:
Click on the Home tab. Open the Paragraph dialog box launcher. Click on the Line and Page Breaks tab. Uncheck the box marked Widow/Orphan Control. Click OK to make the change locally or Default to make this change part of the normal style.

Note: This procedure must be done both in the text and footnotes.

Rework the Paragraph: If this does not work, rewrite the paragraph, paying special attention to the consolidation of clusters of footnotes.
Appendix 1: Guidelines for Writing an Acceptable Critical Book Review

The analysis of books falls basically under two heads: the report and the review. A report is a descriptive but largely non-evaluative summary of the content of a book. A review is a critical interpretive analysis of a book with a view to factors such as its strengths, weaknesses, biases, organization, effectiveness, and credibility. Unless otherwise instructed, seminary book analyses are expected to take the form of a critical book review.

By critical review is not meant a negative review, but one that is analytical and evaluative. A critical review may, in fact, be quite positive, but only after a thorough appraisal of the content of the book.

A critical book review will include:

- Any pertinent qualifications that the author has to write on the topic of the book, paying special attention to other publications, educational background, vocational interests, etc., that might inform or bias his understanding of the topic.
- An establishment of the book’s thesis. Note that the thesis is sometimes stated and sometimes must be inferred, and at times it there may be both a cosmetic and a “real” thesis. A careful reviewer will discern these. State and explain why you believe the author succeeded or failed in proving his thesis.
- A brief, encapsulated summary of the author’s argument. This should appear early in the review and should not exceed 20% of the critical review (note that this is unlike book reviews common in professional journals, which give greater attention to content summaries for the evaluation of prospective buyers). Under no circumstances should a review consist merely of a seriatim summary or abridgement of the book.
- An identification of the author’s arguments, distinguishing principal arguments from lesser ones and giving priority to the former.
- An evaluation of the author’s use of logic, evidence and counter-evidence. Do his arguments follow? Does he ignore/dismiss counter-claims or answer them honestly?
- A demonstration of familiarity with other germane literature, comparing and contrasting these with the book under review and explaining the distinctive contribution of the reviewed work to the body of literature on the topic.
- A summary assessment of either commendation or disapproval. All books have strengths and weaknesses and these should be recognized; however, you should be able to conclude with a succinct, pregnant statement of the book’s overall value for prospective readers.

A critical book review will exclude:

- Lengthy book summaries. Remember, it is a review, not a report.
- Extraneous biographical details that have no bearing on the book’s content.
- Comments about irrelevant editorial minutiae (e.g., misspellings, page layout, etc.) unless these are so poor as to damage the credibility or understandability of the book.
- Ad hominem attacks. If you disagree with the author, explain why he is wrong in a detached, irenic manner.
- Broad, unsubstantiated, and subjective comments (e.g., “this book wasn’t very good”; “I thought the book was interesting”; “this book just didn’t speak to me”). Such sentiments emerge much more effectively and professionally through objective analysis.
## Appendix 2: Abbreviations & Capitalization

### PART 1: ABBREVIATIONS OF THE NAMES OF BIBLICAL BOOKS (WITH THE APOCRYPHA)

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Book Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gen</td>
<td>Song or Cant</td>
</tr>
<tr>
<td>Exod</td>
<td>Isa</td>
</tr>
<tr>
<td>Lev</td>
<td>Jer</td>
</tr>
<tr>
<td>Num</td>
<td>Lam</td>
</tr>
<tr>
<td>Deut</td>
<td>Ezek</td>
</tr>
<tr>
<td>Josh</td>
<td>Dan</td>
</tr>
<tr>
<td>Judg</td>
<td>Hos</td>
</tr>
<tr>
<td>Ruth</td>
<td>Joel</td>
</tr>
<tr>
<td>1–2 Sam</td>
<td>Amos</td>
</tr>
<tr>
<td>1–2 Kgs</td>
<td>Obad</td>
</tr>
<tr>
<td>1–2 Chr</td>
<td>Jonah</td>
</tr>
<tr>
<td>Ezra</td>
<td>Mic</td>
</tr>
<tr>
<td>Neh</td>
<td>Nah</td>
</tr>
<tr>
<td>Esth</td>
<td>Hab</td>
</tr>
<tr>
<td>Job</td>
<td>Zeph</td>
</tr>
<tr>
<td>Ps (pl.: Pss)</td>
<td>Hag</td>
</tr>
<tr>
<td>Prov</td>
<td>Zech</td>
</tr>
<tr>
<td>Eccl (or Qoh)</td>
<td>Mal</td>
</tr>
<tr>
<td>1–2–3–4 Kgdms</td>
<td>Add Esth</td>
</tr>
<tr>
<td></td>
<td>Bar</td>
</tr>
<tr>
<td></td>
<td>Bel</td>
</tr>
<tr>
<td></td>
<td>1–2 Esdr</td>
</tr>
<tr>
<td></td>
<td>4 Ezra</td>
</tr>
<tr>
<td></td>
<td>Jdt</td>
</tr>
<tr>
<td></td>
<td>Ep Jer</td>
</tr>
<tr>
<td></td>
<td>1–2–3–4 Macc</td>
</tr>
<tr>
<td></td>
<td>Pr Azar</td>
</tr>
<tr>
<td></td>
<td>Pr Man</td>
</tr>
<tr>
<td></td>
<td>Sir</td>
</tr>
<tr>
<td></td>
<td>Sus</td>
</tr>
<tr>
<td></td>
<td>Tob</td>
</tr>
<tr>
<td></td>
<td>Wis</td>
</tr>
<tr>
<td></td>
<td>Matt</td>
</tr>
<tr>
<td></td>
<td>Mark</td>
</tr>
<tr>
<td></td>
<td>Luke</td>
</tr>
<tr>
<td>John</td>
<td>Acts</td>
</tr>
<tr>
<td></td>
<td>Rom</td>
</tr>
<tr>
<td></td>
<td>1–2 Cor</td>
</tr>
<tr>
<td></td>
<td>Gal</td>
</tr>
<tr>
<td></td>
<td>Eph</td>
</tr>
<tr>
<td></td>
<td>Phil</td>
</tr>
<tr>
<td></td>
<td>Col</td>
</tr>
<tr>
<td></td>
<td>1–2 Thess</td>
</tr>
<tr>
<td></td>
<td>1–2 Tim</td>
</tr>
<tr>
<td></td>
<td>Titus</td>
</tr>
<tr>
<td></td>
<td>Philm</td>
</tr>
<tr>
<td></td>
<td>Heb</td>
</tr>
<tr>
<td></td>
<td>Jas</td>
</tr>
<tr>
<td></td>
<td>1–2 Pet</td>
</tr>
<tr>
<td></td>
<td>1–2–3 John</td>
</tr>
<tr>
<td></td>
<td>Jude</td>
</tr>
<tr>
<td></td>
<td>Rev</td>
</tr>
</tbody>
</table>

### PART 2: PUBLISHERS’ NAMES: SHORTENED FORMS

- Abingdon Press
- Accent Books
- Augsburg Publishing Co.
- Augsburg Fortress, Publishers
- Baker Book House
- The Banner of Truth Trust
- Bethany House Publishers
- Blackwell Publishers
- Broadman Press
- Broadman & Holman Press
- College Press Publishing Co.
- Concordia Publishing House
- Crossway Books
- Walter de Gruyter
- Doubleday & Co.
- Wm. B. Eerdmans Publishing Co.
- Fortress Press
- Good News Publishers/Crossway Books
- Harper & Row, Publishers
- Harvest House Publishers
- Hendrickson Publishers, Inc.
- Herald Press
- InterVarsity Press
- John Knox Press
<table>
<thead>
<tr>
<th>Publisher</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kregel Publications</td>
<td>Kregel</td>
</tr>
<tr>
<td>Liturgical Press, The</td>
<td>Liturgical</td>
</tr>
<tr>
<td>Loizeaux Brothers</td>
<td>Loizeaux</td>
</tr>
<tr>
<td>Macmillan Co., The</td>
<td>Macmillan</td>
</tr>
<tr>
<td>Edwin Mellen Press</td>
<td>Mellen</td>
</tr>
<tr>
<td>J. C. B. Mohr</td>
<td>Mohr</td>
</tr>
<tr>
<td>Moody Press</td>
<td>Moody Press</td>
</tr>
<tr>
<td>Multnomah Press</td>
<td>Multnomah Press</td>
</tr>
<tr>
<td>Thomas Nelson, Inc.</td>
<td>Nelson</td>
</tr>
<tr>
<td>Oxford University Press</td>
<td>Oxford University Press</td>
</tr>
<tr>
<td>Paternoster Publishing USA</td>
<td>Paternoster</td>
</tr>
<tr>
<td>Paulist Press</td>
<td>Paulist</td>
</tr>
<tr>
<td>P &amp; R Publishing Co.</td>
<td>P &amp; R</td>
</tr>
<tr>
<td>Presbyterian &amp; Reformed Publishing Co.</td>
<td>Presbyterian &amp; Reformed</td>
</tr>
<tr>
<td>Regal Books</td>
<td>Regal</td>
</tr>
<tr>
<td>Fleming H. Revell Co.</td>
<td>Revell</td>
</tr>
<tr>
<td>Charles Scribner’s Sons</td>
<td>Scribner’s</td>
</tr>
<tr>
<td>Sheffield Academic Press</td>
<td>Sheffield</td>
</tr>
<tr>
<td>Tyndale House Publishers, Inc.</td>
<td>Tyndale</td>
</tr>
<tr>
<td>Victor Books</td>
<td>Victor</td>
</tr>
<tr>
<td>The Westminster Press</td>
<td>Westminster</td>
</tr>
<tr>
<td>Word, Inc. or Word Books</td>
<td>Word</td>
</tr>
<tr>
<td>Zondervan Publishing House</td>
<td>Zondervan</td>
</tr>
</tbody>
</table>

**PART 3: TEXTS AND VERSIONS OF THE BIBLE**

**Ancient Texts and Editions**

- **BHK**: Biblia Hebraica, R. Kittel, ed.
- **BHL**: Biblical Hebraica Leningradensia
- **BHS**: Biblia Hebraica Stuttgartensia
- **DSS**: Dead Sea Scrolls
- **LXX**: Septuagint
- **MT**: Masoretic Text
- **NA²⁷**: Novum Testamentum Graece, Nestle-Aland, 27th ed.
- **TR**: Textus Receptus
- **Vg**: Vulgate
- **WH**: Westcott-Hort

**English Versions**

- **AMPLIFIED**: Amplified Bible (1958–65)
- **ARV**: American Revised Version (1901; U.S. edition of ERV)
- **ARV, mg**: American Revised Version, margin
- **ASV**: American Standard Version (1901)
- **AT**: The Complete Bible: An American Translation (Goodspeed and Smith; NT 1923; OT 1927)
- **AV**: Authorized Version (1611; same as KJV)
<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BARCLAY</td>
<td><em>The New Testament</em> (Barclay; 1968–69)</td>
<td></td>
</tr>
<tr>
<td>BECK</td>
<td><em>New Testament in Language of Today</em> (Beck; 1963)</td>
<td></td>
</tr>
<tr>
<td>BISHOP</td>
<td>The Bishop’s Bible (1568)</td>
<td></td>
</tr>
<tr>
<td>BV</td>
<td><em>Berkeley Version in Modern English</em> (NT 1945; OT 1959)</td>
<td></td>
</tr>
<tr>
<td>COVERDALE</td>
<td>Coverdale Bible (1535)</td>
<td></td>
</tr>
<tr>
<td>DV</td>
<td>Douay–Rheims Bible (same as Douay Version; 1609–10)</td>
<td></td>
</tr>
<tr>
<td>DV</td>
<td>Douay Version (1609–10)</td>
<td></td>
</tr>
<tr>
<td>EB</td>
<td><em>Emphasized Bible</em> (Rotherham; NT 1897; OT 1902)</td>
<td></td>
</tr>
<tr>
<td>ERV</td>
<td>English Revised Version (NT 1881; OT 1885; Apoc. 1895; same as RV)</td>
<td></td>
</tr>
<tr>
<td>ERV, mg</td>
<td>English Revised Version, margin</td>
<td></td>
</tr>
<tr>
<td>ESV</td>
<td><em>English Standard Version</em> (2001)</td>
<td></td>
</tr>
<tr>
<td>GENEVA</td>
<td>Geneva Bible (1560)</td>
<td></td>
</tr>
<tr>
<td>GNB</td>
<td><em>Good News Bible</em> (same as TEV; NT 1966; OT 1976)</td>
<td></td>
</tr>
<tr>
<td>GOODSPEED</td>
<td><em>The Complete Bible: An American Translation</em>, E. J. Goodspeed (NT 1935; OT 1939)</td>
<td></td>
</tr>
<tr>
<td>HCSB</td>
<td><em>Holman Christian Standard Bible</em> (NT 2000)</td>
<td></td>
</tr>
<tr>
<td>JB</td>
<td><em>Jerusalem Bible</em> (French 1956; English 1966)</td>
<td></td>
</tr>
<tr>
<td>JPS</td>
<td><em>Holy Scriptures: Jewish Publication Society Version of the Old Testament</em> (1917)</td>
<td></td>
</tr>
<tr>
<td>KJII</td>
<td><em>King James II Version</em> (1971)</td>
<td></td>
</tr>
<tr>
<td>KJV</td>
<td>King James Version (same as Authorized Version; 1611)</td>
<td></td>
</tr>
<tr>
<td>KNOX</td>
<td><em>Holy Bible: A Translation from the Latin Vulgate in the Light of the Hebrew and Greek Original</em> (Knox; NT 1945; OT 1949)</td>
<td></td>
</tr>
<tr>
<td>LAMSA</td>
<td><em>Holy Bible from Ancient Eastern Manuscripts</em> (Lamsa; 1957)</td>
<td></td>
</tr>
<tr>
<td>LB</td>
<td><em>The Living Bible</em> (NT 1967; OT 1971)</td>
<td></td>
</tr>
<tr>
<td>LB</td>
<td><em>The Book</em> (same as <em>The Living Bible</em>)</td>
<td></td>
</tr>
<tr>
<td>MATTHEW</td>
<td>Matthew’s Bible (1537)</td>
<td></td>
</tr>
<tr>
<td>MLB</td>
<td><em>Modern Language Bible</em> (same as <em>New Berkeley Version</em>; 1969)</td>
<td></td>
</tr>
<tr>
<td>MLB</td>
<td><em>New Berkeley Version in Modern English</em> (same as <em>Modern Language Bible</em>; 1969)</td>
<td></td>
</tr>
<tr>
<td>MOFFATT</td>
<td><em>A New Translation of the Bible</em> (Moffatt; NT 1913; OT 1924)</td>
<td></td>
</tr>
<tr>
<td>NAB</td>
<td><em>New American Bible</em> (NT 1941; OT 1969)</td>
<td></td>
</tr>
<tr>
<td>NASB</td>
<td><em>New American Standard Bible</em> (NT 1963; OT 1971)</td>
<td></td>
</tr>
<tr>
<td>NAV</td>
<td><em>New American Version</em></td>
<td></td>
</tr>
<tr>
<td>NEB</td>
<td><em>New English Bible</em> (NT 1961; OT and Apoc. 1970)</td>
<td></td>
</tr>
<tr>
<td>NIRV</td>
<td><em>New International Reader’s Version</em> (OT 1995; NT 1996; revised 1998)</td>
<td></td>
</tr>
<tr>
<td>NIV</td>
<td><em>New International Version</em> (NT 1973; OT 1978)</td>
<td></td>
</tr>
<tr>
<td>NIVSB</td>
<td><em>NIV Study Bible</em> (1985)</td>
<td></td>
</tr>
<tr>
<td>NJB</td>
<td><em>New Jerusalem Bible</em> (1985)</td>
<td></td>
</tr>
<tr>
<td>NJV</td>
<td><em>New Jewish Version</em> (1962–82)</td>
<td></td>
</tr>
<tr>
<td>NKJV</td>
<td><em>New King James Version</em> (1979)</td>
<td></td>
</tr>
<tr>
<td>NLT</td>
<td><em>New Living Translation</em> (1996)</td>
<td></td>
</tr>
<tr>
<td>NLTse</td>
<td><em>New Living Translation, 2nd ed.</em> (2004)</td>
<td></td>
</tr>
</tbody>
</table>
PART 4: ABBREVIATIONS OF COMMONLY USED PERIODICALS, REFERENCE WORKS, & SERIALS

AARSBLA American Academy of Religion/Society of Biblical Literature Abstracts
AASOR Annual of the American Schools of Oriental Research
AB Anchor Bible
ABD Anchor Bible Dictionary, D. N. Freedman (ed.)
ABQ American Baptist Quarterly
ACCS Ancient Christian Commentary on Scripture
ACW Ancient Christian Writers
AJA American Journal of Archaeology
AJBA Australian Journal of Biblical Archaeology
AJP American Journal of Philology
AJSL American Journal of Semitic Languages and Literature
AJT American Journal of Theology
ALUOS Annual of Leeds University Oriental Society
AnBib Analecta Biblica
ANEPE Ancient Near East in Pictures, J. B. Pritchard (ed.)
ANESTPP Ancient Near East Supplementary Texts and Pictures, J. B. Pritchard (ed.)
ANET Ancient Near Eastern Texts, J. B. Pritchard (ed.)
ANF The Ante-Nicene Fathers
ANQ Andover Newton Quarterly
ANRW Aufstieg und Niedergang der römischen Welt
AOS American Oriental Series
AOSTS American Oriental Society Translation Series
APOT Apocrypha and Pseudepigrapha of the Old Testament, R. H. Charles (ed.)
ARE        *Ancient Records of Egypt, J. H. Breasted (ed.)*
ASOR       American Schools of Oriental Research
ASP        American Studies in Papyrology
AsTJ       *Asbury Theological Journal*
ATJ        *Ashland Theological Journal*
ATR        *Anglican Theological Review*
AusBR      *Australian Biblical Review*
AUSS       *Andrews University Seminary Studies*

BA          *Biblical Archaeologist*
BAR         *Biblical Archaeologist Reader*
BARrev      *Biblical Archaeology Review*
BASOR       *Bulletin of the American Schools of Oriental Research*
BASP        *Bulletin of the American Society of Papyrologists*
BBR        *Bulletin of Biblical Research*
BCOTWP      Baker Commentary on the Old Testament Wisdom and Psalms
BCSR        *Bulletin of the Council of the Study of Religion*
BDF        F. Blass, A. Debrunner, and R. W. Funk, *A Greek Grammar of the NT*
BDR        F. Blass, A. Debrunner, and F. Rehkopf, *Grammatik des neutestamentlichen Griechisch*
BECNT      Baker Exegetical Commentary on the New Testament
BETS        *Bulletin of the Evangelical Theological Society*
BFT        Biblical Foundations in Theology
BHS        *Biblia Hebraica Stuttgartensia*
Bib        Biblica
BibInt     Biblical Interpretation
BibRev     Bible Review
BIES       *Bulletin of the Israel Exploration Society (=Yediot)*
BIOSCS     *Bulletin of the International Organization for Septuagint and Cognate Studies*
BJPES      *Bulletin of the Jewish Palestine Exploration Society*
BJRL       *Bulletin of the John Rylands University Library of Manchester*
BJS        Brown Judaic Studies
BK         *Bibel und Kirche*
BN         *Biblische Notizen*
BNTC       Black’s New Testament Commentary
BO         *Bibliotheca orientalis*
BQ         Baptist Quarterly
BR         Biblical Research
BRT        Baptist Review of Theology
BSac       *Bibliotheca Sacra*
BSC        Bible Student’s Commentary
BST        Bible Speaks Today
BT         *The Bible Translator*
BTB        *Biblical Theology Bulletin*
BurH       Buried History
BZ         *Biblische Zeitschrift*
BZAW       Beihefte zur Zeitschrift für die alttestamentliche Wissenschaft t
BZNW       Beihefte zur Zeitschrift für die neuestamentliche Wissenschaft

CAD        *The Assyrian Dictionary of the Oriental Institute of the University of Chicago*
CAH        Cambridge Ancient History
CANE  Civilizations of the Ancient Near East, J. Sasson (ed.)
CBC  Cambridge Bible Commentary
CBQ  Catholic Biblical Quarterly
CBQMS Catholic Biblical Quarterly—Monograph Series
CC  Communicators Commentary
CGTC Cambridge Greek Testament Commentaries
CH  Church History
CHR  Catholic Historical Review
CJT  Canadian Journal of Theology
CP  Classical Philology
CQ  Church Quarterly
CQR  Church Quarterly Review
CR  Critical Review of Books in Religion
CRBR Critical Review of Books in Religion
CSR  Christian Scholar’s Review
CTJ  Calvin Theological Journal
CTM  Concordia Theological Monthly
CTQ  Concordia Theological Quarterly
CTR  Criswell Theological Review
CurTM  Currents in Theology and Mission

DBI Dictionary of Biblical Imagery, L. Ryken et al. (eds.)
DBSJ Detroit Baptist Seminary Journal
DCH Dictionary of Classical Hebrew, D. J. A. Clines (ed.)
DHT Dictionary of Historical Theology, T. A. Hart (ed.)
DJD Discoveries in the Judean Desert
DJG Dictionary of Jesus and the Gospels, J. B. Green et al. (eds.)
DOTT Documents from Old Testament Times, D. W. Thomas (ed.)
DNTB Dictionary of New Testament Background, C. A. Evans and S. E. Porter (eds.)
DPL Dictionary of Paul and His Letters, G. F. Hawthorne et al. (eds.)
DSD Dead Sea Discoveries

ECC Eerdmans’ Critical Commentary
EDB Encyclopedic Dictionary of the Bible, L. F. Hartman (ed.)
EDT Evangelical Dictionary of Theology, W. A. Elwell (ed.)
EDBT Evangelical Dictionary of Biblical Theology, W. A. Elwell (ed.)
EDNT Exegetical Dictionary of the New Testament, H. Balz and G. Schneider (eds.)
EJT European Journal of Theology
EMQ Evangelical Missions Quarterly
EncJud Encyclopaedia Judaica (1971)
ErIsr Eretz Israel
EvJ Evangelical Journal
EvQ Evangelical Quarterly
EvT Evangelische Theologie
EWNT Exegetisches Wörterbuch zum Neuen Testament, H. Balz and G. Schneider (eds.)
ExpTim Expository Times

FC Fathers of the Church
FOTL Forms of the Old Testament Literature

GKC Gesenius’ Hebrew Grammar, ed. E. Kautzsch, tr. A. E. Cowley
GNS Good News Studies
GOTR Greek Orthodox Theological Review
GTJ Grace Theological Journal
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>HALOT</td>
<td><em>Hebrew and Aramaic Lexicon of the Old Testament</em>, W. Baumgartner et al. (eds.)</td>
</tr>
<tr>
<td>HAR</td>
<td>Hebrew Annual Review</td>
</tr>
<tr>
<td>HBC</td>
<td><em>Harper’s Bible Commentary</em>, J. L. Mays et al. (eds.)</td>
</tr>
<tr>
<td>HBD</td>
<td><em>Harper’s Bible Dictionary</em>, P. J. Achtemeier et al. (eds.)</td>
</tr>
<tr>
<td>HBT</td>
<td><em>Horizons in Biblical Theology</em></td>
</tr>
<tr>
<td>HDR</td>
<td>Harvard Dissertations in Religion</td>
</tr>
<tr>
<td>HeyJ</td>
<td><em>Heythrop Journal</em></td>
</tr>
<tr>
<td>HNTC</td>
<td>Harper’s NT Commentaries</td>
</tr>
<tr>
<td>HolNNTC</td>
<td>Holman New Testament Commentary</td>
</tr>
<tr>
<td>HR</td>
<td><em>History of Religions</em></td>
</tr>
<tr>
<td>HS</td>
<td>Hebrew Studies</td>
</tr>
<tr>
<td>HSM</td>
<td>Harvard Semitic Monographs</td>
</tr>
<tr>
<td>HSS</td>
<td>Harvard Semitic Studies</td>
</tr>
<tr>
<td>HTR</td>
<td><em>Harvard Theological Review</em></td>
</tr>
<tr>
<td>HTS</td>
<td>Harvard Theological Studies</td>
</tr>
<tr>
<td>HUCA</td>
<td>Hebrew Union College Annual</td>
</tr>
<tr>
<td>HUCM</td>
<td>Monographs of the Hebrew Union College</td>
</tr>
<tr>
<td>IB</td>
<td><em>Interpreter’s Bible</em></td>
</tr>
<tr>
<td>IBC</td>
<td>Interpretation: A Bible Commentary for Teaching and Preaching</td>
</tr>
<tr>
<td>IBS</td>
<td><em>Irish Biblical Studies</em></td>
</tr>
<tr>
<td>ICC</td>
<td>International Critical Commentary</td>
</tr>
<tr>
<td>IDB</td>
<td><em>Interpreter’s Dictionary of the Bible</em>, G. A. Buttrick (ed.)</td>
</tr>
<tr>
<td>IDBSup</td>
<td>Supplementary volume to IDB</td>
</tr>
<tr>
<td>IEJ</td>
<td><em>Israel Exploration Journal</em></td>
</tr>
<tr>
<td>Int</td>
<td>Interpretation</td>
</tr>
<tr>
<td>IOS</td>
<td>Israel Oriental Society</td>
</tr>
<tr>
<td>ITC</td>
<td>International Theological Commentary</td>
</tr>
<tr>
<td>ITQ</td>
<td><em>Irish Theological Quarterly</em></td>
</tr>
<tr>
<td>IVPNNTC</td>
<td>IVP New Testament Commentary</td>
</tr>
<tr>
<td>JAAR</td>
<td>Journal of the American Academy of Religion</td>
</tr>
<tr>
<td>JANESCU</td>
<td>Journal of the Ancient Near Eastern Society of Columbia University</td>
</tr>
<tr>
<td>JAOS</td>
<td>Journal of the American Oriental Society</td>
</tr>
<tr>
<td>JAS</td>
<td>Journal of Asian Studies</td>
</tr>
<tr>
<td>JBC</td>
<td><em>The Jerome Biblical Commentary</em>, R. E. Brown et al. (eds.)</td>
</tr>
<tr>
<td>JBL</td>
<td><em>Journal of Biblical Literature</em></td>
</tr>
<tr>
<td>JBQ</td>
<td>Jewish Bible Quarterly</td>
</tr>
<tr>
<td>JBR</td>
<td><em>Journal of Bible and Religion</em></td>
</tr>
<tr>
<td>JCS</td>
<td>Journal of Cuneiform Studies</td>
</tr>
<tr>
<td>JECS</td>
<td>Journal of Early Christian Studies</td>
</tr>
<tr>
<td>JEH</td>
<td>Journal of Ecclesiastical History</td>
</tr>
<tr>
<td>JES</td>
<td>Journal of Ecumenical Studies</td>
</tr>
<tr>
<td>JETS</td>
<td>Journal of the Evangelical Theological Society</td>
</tr>
<tr>
<td>JFSR</td>
<td>Journal of Feminist Studies in Religion</td>
</tr>
<tr>
<td>JHNES</td>
<td>Johns Hopkins Near Eastern Studies</td>
</tr>
<tr>
<td>JJS</td>
<td>Journal of Jewish Studies</td>
</tr>
<tr>
<td>JNES</td>
<td>Journal of Near Eastern Studies</td>
</tr>
<tr>
<td>JNSL</td>
<td>Journal of Northwest Semitic Languages</td>
</tr>
<tr>
<td>JOTT</td>
<td>Journal of Translation and Textlinguistics</td>
</tr>
<tr>
<td>JPOS</td>
<td>Journal of Palestine Oriental Society</td>
</tr>
<tr>
<td>JQR</td>
<td><em>Jewish Quarterly Review</em></td>
</tr>
<tr>
<td>JQRMES</td>
<td>Jewish Quarterly Review Monograph Series</td>
</tr>
<tr>
<td>JR</td>
<td><em>Journal of Religion</em></td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Title</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>JRE</td>
<td>Journal of Religious Ethics</td>
</tr>
<tr>
<td>JRelS</td>
<td>Journal of Religious Studies</td>
</tr>
<tr>
<td>JRH</td>
<td>Journal of Religious History</td>
</tr>
<tr>
<td>JSNT</td>
<td>Journal for the Study of the New Testament</td>
</tr>
<tr>
<td>JSNTSup</td>
<td>Journal for the Study of the New Testament—Supplement Series</td>
</tr>
<tr>
<td>JSOT</td>
<td>Journal for the Study of the Old Testament</td>
</tr>
<tr>
<td>JSOTSup</td>
<td>Journal for the Study of the Old Testament—Supplement Series</td>
</tr>
<tr>
<td>JSP</td>
<td>Journal for the Study of the Pseudepigrapha</td>
</tr>
<tr>
<td>JSPSup</td>
<td>Journal for the Study of the Pseudepigrapha—Supplement Series</td>
</tr>
<tr>
<td>JSS</td>
<td>Journal of Semitic Studies</td>
</tr>
<tr>
<td>JSSR</td>
<td>Journal for the Scientific Study of Religion</td>
</tr>
<tr>
<td>JTC</td>
<td>Journal for Theology and the Church</td>
</tr>
<tr>
<td>JTS</td>
<td>Journal of Theological Studies</td>
</tr>
<tr>
<td>KB</td>
<td>L. Koehler and W. Baumgartner, <em>Lexicon in Veteris Testamenti libros</em></td>
</tr>
<tr>
<td>LCC</td>
<td>Library of Christian Classics</td>
</tr>
<tr>
<td>LCL</td>
<td>Loeb Classical Library</td>
</tr>
<tr>
<td>LPGL</td>
<td>G. W. H. Lampe, <em>Patristic Greek Lexicon</em></td>
</tr>
<tr>
<td>LQ</td>
<td>Lutheran Quarterly</td>
</tr>
<tr>
<td>LS</td>
<td>Louvain Studies</td>
</tr>
<tr>
<td>LSI</td>
<td>Liddell-Scott-Jones, <em>Greek–English Lexicon</em></td>
</tr>
<tr>
<td>LTQ</td>
<td>Lexington Theological Quarterly</td>
</tr>
<tr>
<td>MC</td>
<td>Modern Churchman</td>
</tr>
<tr>
<td>MM</td>
<td>J. H. Moulton and G. Milligan, <em>The Vocabulary of the Greek Testament</em></td>
</tr>
<tr>
<td>MNTC</td>
<td>Moffatt NT Commentary</td>
</tr>
<tr>
<td>NAC</td>
<td>New American Commentary</td>
</tr>
<tr>
<td>NBC</td>
<td>New Bible Commentary</td>
</tr>
<tr>
<td>NBD</td>
<td><em>New Bible Dictionary</em>, J. D. Douglas (ed.)</td>
</tr>
<tr>
<td>NCB</td>
<td>New Century Bible</td>
</tr>
<tr>
<td>NCCHS</td>
<td>New Catholic Commentary on Holy Scripture, R. D. Fuller et al. (eds.)</td>
</tr>
<tr>
<td>NCE</td>
<td>New Catholic Encyclopedia, M. R. P. McGuire et al. (eds.)</td>
</tr>
<tr>
<td>NDBT</td>
<td><em>New Dictionary of Biblical Theology</em>, T. D. Alexander et al. (eds.)</td>
</tr>
<tr>
<td>Neot</td>
<td>Neotestamentica</td>
</tr>
<tr>
<td>NHS</td>
<td>Nag Hammadi Studies</td>
</tr>
<tr>
<td>NIB</td>
<td>New Interpreter’s Bible</td>
</tr>
<tr>
<td>NICNT</td>
<td>New International Commentary on the New Testament</td>
</tr>
<tr>
<td>NICOT</td>
<td>New International Commentary on the Old Testament</td>
</tr>
<tr>
<td>NIGTC</td>
<td>The New International Greek Testament Commentary</td>
</tr>
<tr>
<td>NIVAC</td>
<td>NIV Application Commentary</td>
</tr>
<tr>
<td>NJBC</td>
<td>The New Jerome Biblical Commentary, R. E. Brown et al. (eds.)</td>
</tr>
<tr>
<td>NovT</td>
<td>Novum Testamentum</td>
</tr>
<tr>
<td>NovTSup</td>
<td>Novum Testamentum, Supplements</td>
</tr>
<tr>
<td>NPNF</td>
<td>Nicene and Post-Nicene Fathers</td>
</tr>
<tr>
<td>NTA</td>
<td>New Testament Abstracts</td>
</tr>
<tr>
<td>NTG</td>
<td>New Testament Guides</td>
</tr>
<tr>
<td>NTL</td>
<td>New Testament Library</td>
</tr>
<tr>
<td>NTS</td>
<td>New Testament Studies</td>
</tr>
<tr>
<td>NTTS</td>
<td>New Testament Tools and Studies</td>
</tr>
<tr>
<td>Numen</td>
<td><em>Numen: International Review for the History of Religions</em></td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Title</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>Sem</td>
<td>Semitica</td>
</tr>
<tr>
<td>SHT</td>
<td>Studies in Historical Theology</td>
</tr>
<tr>
<td>SJLA</td>
<td>Studies in Judaism in Late Antiquity</td>
</tr>
<tr>
<td>SJOT</td>
<td>Scandinavian Journal of the Old Testament</td>
</tr>
<tr>
<td>SJT</td>
<td>Scottish Journal of Theology</td>
</tr>
<tr>
<td>SNTSMS</td>
<td>Society for New Testament Studies Monograph Series</td>
</tr>
<tr>
<td>SOTSMS</td>
<td>Society for Old Testament Study Monograph Series</td>
</tr>
<tr>
<td>SP</td>
<td>Sacra Pagina</td>
</tr>
<tr>
<td>ST</td>
<td>Studia Theologica</td>
</tr>
<tr>
<td>STDJ</td>
<td>Studies on the Texts of the Desert of Judah</td>
</tr>
<tr>
<td>STJ</td>
<td>Studios Theological Journal</td>
</tr>
<tr>
<td>StudBT</td>
<td>Studia Biblica et Theologica</td>
</tr>
<tr>
<td>SiVTQ</td>
<td>Saint Vladimir's Theological Quarterly</td>
</tr>
<tr>
<td>SwJT</td>
<td>Southwestern Journal of Theology</td>
</tr>
<tr>
<td>TBT</td>
<td>The Bible Today</td>
</tr>
<tr>
<td>TCGNT</td>
<td>A Textual Commentary on the Greek New Testament, B. M. Metzger</td>
</tr>
<tr>
<td>TD</td>
<td>Theology Digest</td>
</tr>
<tr>
<td>TDNT</td>
<td>Theological Dictionary of the New Testament, G. Kittel and G. Friedrich (eds.)</td>
</tr>
<tr>
<td>TDOT</td>
<td>Theological Dictionary of the Old Testament, G. J. Botterweck and H. Ringgren (eds.)</td>
</tr>
<tr>
<td>TLG</td>
<td>Thesaurae Lingua Graecae</td>
</tr>
<tr>
<td>TMSJ</td>
<td>The Master's Seminary Journal</td>
</tr>
<tr>
<td>TNNTC</td>
<td>Tyndale New Testament Commentaries</td>
</tr>
<tr>
<td>TOTC</td>
<td>Tyndale Old Testament Commentaries</td>
</tr>
<tr>
<td>TRev</td>
<td>Theological Review</td>
</tr>
<tr>
<td>TrinJ</td>
<td>Trinity Journal</td>
</tr>
<tr>
<td>TS</td>
<td>Theological Studies</td>
</tr>
<tr>
<td>TSFB</td>
<td>Theological Students' Fellowship Bulletin</td>
</tr>
<tr>
<td>TSK</td>
<td>Theologische Studien und Kritiken</td>
</tr>
<tr>
<td>TTodday</td>
<td>Theology Today</td>
</tr>
<tr>
<td>TWAT</td>
<td>Theologisches Wörterbuch zum Alten Testament, G. J. Botterweck and H. Ringgren (eds.)</td>
</tr>
<tr>
<td>TWNT</td>
<td>Theologisches Wörterbuch zum Neuen Testament, G. Kittel and G. Friedrich (eds.)</td>
</tr>
<tr>
<td>TWOT</td>
<td>Theological Wordbook of the Old Testament, R. L. Harris et al. (eds.)</td>
</tr>
<tr>
<td>TynBul</td>
<td>Tyndale Bulletin</td>
</tr>
<tr>
<td>TZ</td>
<td>Theologische Zeitschrift</td>
</tr>
<tr>
<td>UBSGNT</td>
<td>United Bible Societies Greek New Testament</td>
</tr>
<tr>
<td>UF</td>
<td>Ugarit-Forschungen</td>
</tr>
<tr>
<td>USQR</td>
<td>Union Seminary Quarterly Review</td>
</tr>
<tr>
<td>UT</td>
<td>Ugaritic Textbook, C. H. Gordon</td>
</tr>
<tr>
<td>VC</td>
<td>Vigiliae Christianae</td>
</tr>
<tr>
<td>VT</td>
<td>Vetus Testamentum</td>
</tr>
<tr>
<td>VTSup</td>
<td>Vetus Testamentum Supplements</td>
</tr>
<tr>
<td>WBC</td>
<td>Word Biblical Commentary</td>
</tr>
<tr>
<td>WEC</td>
<td>Wycliffe Exegetical Commentary</td>
</tr>
<tr>
<td>WestIJ</td>
<td>Wesleyan Theological Journal</td>
</tr>
<tr>
<td>WDB</td>
<td>Westminster Dictionary of the Bible</td>
</tr>
<tr>
<td>WHAB</td>
<td>Westminster Historical Atlas of the Bible</td>
</tr>
<tr>
<td>WTJ</td>
<td>Westminster Theological Journal</td>
</tr>
<tr>
<td>WW</td>
<td>Word and World</td>
</tr>
<tr>
<td>ZAW</td>
<td>Zeitschrift für die alttestamentliche Wissenschaft</td>
</tr>
<tr>
<td>ZNW</td>
<td>Zeitschrift für die neuestamentliche Wissenschaft</td>
</tr>
<tr>
<td>ZPEB</td>
<td>Zondervan Pictorial Encyclopedia of the Bible</td>
</tr>
<tr>
<td>ZTK</td>
<td>Zeitschrift für Theologie und Kirche</td>
</tr>
</tbody>
</table>
PART 5: CAPITALIZATION OF COMMONLY USED RELIGIOUS TERMS
with additions from The SBL Handbook of Style [Hendrickson, 1999])

Aaronic priesthood
ablative
Abba
abomination of desolation
Abrahamic covenant
Abraham’s Bosom
Abraham’s side
Abyss, the
accusative
ad hoc
Adapa
Adonai
Advent, the
Advent season
Advocate, the
age of grace
age to come, the
Age (for archaeological periods, such as Bronze Age and Iron Age)
agnosticism
agraphon, pl. agrapha
Akkadian
Almighty, the
almighty God
Aleppo Codex
Alpha and Omega (Christ)
Amarna age, letters, tablets
amillenarian
amillennial(ism)(ist)
ancient Near East(ern)
Ancient of Days, the (God)
angel (cap. if theophany)
angel Gabriel, the
angel of the Lord (cap. if theophany)
Annunciation, the
Anointed, the (Christ)
Anointed One, the (Christ)
anointing of the sick
ante-Christian
antediluvian
ante-Nicene fathers
anti-Catholic
antichrist (the general spirit)
Antichrist (the person)
anti-Christian
antichurch
antilegomena
anti-God
anti-Semitism
anti-Trinitarian
Apocalypse, the (Revelation of John)
apocalyptic
Apocrypha, the
apocryphal (cap. only if Apocrypha is meant)
a posteriori
apostle Peter et al.
Apostle to the Gentiles (Paul)
apostles, the
Apostles’ Creed
apostolic age
apostolic benediction (2 Cor 13)
apostolic council (Acts 15)
apostolic faith
Apostolic Fathers (corpus of writings)
a priori
Aramaean
archangel
archaeology
archbishop of Canterbury (but Archbishop Smith)
ark, the (Noah’s)
ar of testimony
ark of the covenant
Arminian(ism)
Ascension, the
Ascension Day
Assyrian Empire
Assyrian King List
Athanasiian Creed
atheism, -ist
atonement
Atonement, the
Atonement, the Day of
Augsburg Confession
Baal
baalism
babe in the manger, the
baby Jesus, the
Babylonian captivity (Jews)
Babylonian Empire
baptism
baptism in/with/of the Holy Spirit
Baptism, the (of Christ)
Battle of Armageddon (final battle)
battle of Carchemish, etc.
Beast, the (Antichrist)
Beatitudes, the
Beelzebub
being
Being (God)
Beloved Apostle, the
Betrayal, the
Decalogue
Defender (God)
deism, -ist
Deity, the
deity of Christ
Deluge, the (the Flood)
demon(ic)
Deuteronomic
devil, a
Devil, the (Satan)
Diaspora
disciples
dispensation(alism)(alist)
dispensation of the Law
Dispersion, the
divided kingdom/monarchy (period of history)
divine
Divine Father
divine guidance
Divine Providence (God)
Divine Warrior
Divinity, the (God)
divinity of Christ, the
Door, the (Christ)
doxology
Dragon, the (Satan)
Dynasty, Eighteenth, etc.

early church
early church fathers (cap. as title of work)
Easter Sunday
Eastern church
Eastern Orthodox Church
Eastern religions
Eastern Rites
ecumenism, -ical
El
elect, God’s
Eleven, the
Elohim
El Shaddai
e-mail
Emmaus road
emperor, an
Emperor Nero
empire, an
Empire (as in Assyrian Empire, Roman Empire)
end times, the
end-times
Enemy, the (Satan)
Epiphany
epistle (John’s epistle et al.)
epistle to the Romans
Epistles, the (NT apostolic letters)
eschatology, -ical
Eternal, the (God)
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>free will</td>
<td></td>
</tr>
<tr>
<td>fundamentalist(s), -ism</td>
<td></td>
</tr>
<tr>
<td>fundamentals of the faith</td>
<td></td>
</tr>
<tr>
<td>Galilean, the (Christ)</td>
<td></td>
</tr>
<tr>
<td>Garden of Eden</td>
<td></td>
</tr>
<tr>
<td>Garden of Gethsemane</td>
<td></td>
</tr>
<tr>
<td>gehenna</td>
<td></td>
</tr>
<tr>
<td>Gemara</td>
<td></td>
</tr>
<tr>
<td>General Epistles</td>
<td></td>
</tr>
<tr>
<td>genitive</td>
<td></td>
</tr>
<tr>
<td>Gentile, a (distinguished from Jew)</td>
<td></td>
</tr>
<tr>
<td>gentile laws</td>
<td></td>
</tr>
<tr>
<td>Gloria Patri</td>
<td></td>
</tr>
<tr>
<td>gnostic (generic)</td>
<td></td>
</tr>
<tr>
<td>Gnostic(ism) (specific sect)</td>
<td></td>
</tr>
<tr>
<td>God (Yahweh)</td>
<td></td>
</tr>
<tr>
<td>god (pagan)</td>
<td></td>
</tr>
<tr>
<td>Godhead (essential being of God)</td>
<td></td>
</tr>
<tr>
<td>godhead (godhood or godship)</td>
<td></td>
</tr>
<tr>
<td>godless</td>
<td></td>
</tr>
<tr>
<td>godlike</td>
<td></td>
</tr>
<tr>
<td>godly</td>
<td></td>
</tr>
<tr>
<td>God-man</td>
<td></td>
</tr>
<tr>
<td>godsend</td>
<td></td>
</tr>
<tr>
<td>God’s house</td>
<td></td>
</tr>
<tr>
<td>Gods speed</td>
<td></td>
</tr>
<tr>
<td>God’s Word (the Bible)</td>
<td></td>
</tr>
<tr>
<td>God’s word (his promise)</td>
<td></td>
</tr>
<tr>
<td>godward</td>
<td></td>
</tr>
<tr>
<td>golden calf, the</td>
<td></td>
</tr>
<tr>
<td>golden candlesticks, the</td>
<td></td>
</tr>
<tr>
<td>Golden Rule, the</td>
<td></td>
</tr>
<tr>
<td>Good Book, the</td>
<td></td>
</tr>
<tr>
<td>Good Friday</td>
<td></td>
</tr>
<tr>
<td>Good News, the</td>
<td></td>
</tr>
<tr>
<td>Good Samaritan</td>
<td></td>
</tr>
<tr>
<td>Good Shepherd (Jesus)</td>
<td></td>
</tr>
<tr>
<td>good shepherd, the parable of the gospel (John’s gospel et al.)</td>
<td></td>
</tr>
<tr>
<td>gospel of Matthew</td>
<td></td>
</tr>
<tr>
<td>Gospels, the</td>
<td></td>
</tr>
<tr>
<td>gospel truth</td>
<td></td>
</tr>
<tr>
<td>grain offering</td>
<td></td>
</tr>
<tr>
<td>Great Awakening, the</td>
<td></td>
</tr>
<tr>
<td>Great Commandment, the</td>
<td></td>
</tr>
<tr>
<td>Great Commission, the</td>
<td></td>
</tr>
<tr>
<td>Great High Priest, the</td>
<td></td>
</tr>
<tr>
<td>Great Judgment, the</td>
<td></td>
</tr>
<tr>
<td>Great Physician, the</td>
<td></td>
</tr>
<tr>
<td>Great Shepherd, the</td>
<td></td>
</tr>
<tr>
<td>Great Tribulation, the</td>
<td></td>
</tr>
<tr>
<td>Great White Throne, the</td>
<td></td>
</tr>
<tr>
<td>Greek</td>
<td></td>
</tr>
<tr>
<td>Ground of Being</td>
<td></td>
</tr>
<tr>
<td>Guide, the (Holy Spirit)</td>
<td></td>
</tr>
<tr>
<td>guilt offering</td>
<td></td>
</tr>
<tr>
<td>hades</td>
<td></td>
</tr>
<tr>
<td>haggadah</td>
<td></td>
</tr>
<tr>
<td>Hagiographa</td>
<td></td>
</tr>
<tr>
<td>hagiographer</td>
<td></td>
</tr>
<tr>
<td>hagiographic</td>
<td></td>
</tr>
<tr>
<td>Hail Mary</td>
<td></td>
</tr>
<tr>
<td>halakah</td>
<td></td>
</tr>
<tr>
<td>Hallel</td>
<td></td>
</tr>
<tr>
<td>Hanukkah (Feast of the Dedication)</td>
<td></td>
</tr>
<tr>
<td>hapax legomenon</td>
<td></td>
</tr>
<tr>
<td>Head, the (Christ head of the church)</td>
<td></td>
</tr>
<tr>
<td>heaven (abode of the redeemed)</td>
<td></td>
</tr>
<tr>
<td>heavenly Father</td>
<td></td>
</tr>
<tr>
<td>Heidelberg Catechism</td>
<td></td>
</tr>
<tr>
<td>Heilsgrichte</td>
<td></td>
</tr>
<tr>
<td>hell</td>
<td></td>
</tr>
<tr>
<td>Hellenism (tic)</td>
<td></td>
</tr>
<tr>
<td>hellenize</td>
<td></td>
</tr>
<tr>
<td>Herodian</td>
<td></td>
</tr>
<tr>
<td>Herod’s temple</td>
<td></td>
</tr>
<tr>
<td>hesed</td>
<td></td>
</tr>
<tr>
<td>high church</td>
<td></td>
</tr>
<tr>
<td>High Priest, the (Christ)</td>
<td></td>
</tr>
<tr>
<td>high priest, a</td>
<td></td>
</tr>
<tr>
<td>High Priestly Prayer, the</td>
<td></td>
</tr>
<tr>
<td>Historical Books, the</td>
<td></td>
</tr>
<tr>
<td>holiness</td>
<td></td>
</tr>
<tr>
<td>Holiness Code (Lev 17–26)</td>
<td></td>
</tr>
<tr>
<td>Holiness Movement, the</td>
<td></td>
</tr>
<tr>
<td>Holy Bible</td>
<td></td>
</tr>
<tr>
<td>Holy Book (Bible)</td>
<td></td>
</tr>
<tr>
<td>Holy City (present or New Jerusalem)</td>
<td></td>
</tr>
<tr>
<td>Holy Communion</td>
<td></td>
</tr>
<tr>
<td>holy day of obligation</td>
<td></td>
</tr>
<tr>
<td>Holy Eucharist</td>
<td></td>
</tr>
<tr>
<td>holy family</td>
<td></td>
</tr>
<tr>
<td>Holy Ghost (prefer Holy Spirit)</td>
<td></td>
</tr>
<tr>
<td>Holy Grail</td>
<td></td>
</tr>
<tr>
<td>Holy Land (Palestine)</td>
<td></td>
</tr>
<tr>
<td>Holy of Holies</td>
<td></td>
</tr>
<tr>
<td>holy oil</td>
<td></td>
</tr>
<tr>
<td>Holy One, the (God, Christ)</td>
<td></td>
</tr>
<tr>
<td>holy order(s)</td>
<td></td>
</tr>
<tr>
<td>Holy Place</td>
<td></td>
</tr>
<tr>
<td>Holy Roller</td>
<td></td>
</tr>
<tr>
<td>Holy Saturday</td>
<td></td>
</tr>
<tr>
<td>Holy Scriptures</td>
<td></td>
</tr>
<tr>
<td>Holy See</td>
<td></td>
</tr>
<tr>
<td>Holy Spirit</td>
<td></td>
</tr>
<tr>
<td>Holy Thursday</td>
<td></td>
</tr>
<tr>
<td>Holy Trinity</td>
<td></td>
</tr>
<tr>
<td>holy war</td>
<td></td>
</tr>
<tr>
<td>holy water</td>
<td></td>
</tr>
<tr>
<td>Holy Week (before Easter)</td>
<td></td>
</tr>
</tbody>
</table>
Holy Writ (Bible)
Holy Year (Catholic)
homologoumena
house of David
house of the Lord
humanity
idolatry
imago Dei
Immaculate Conception, the
Immanuel
Incarnation, the
incarnation of Christ
infant Jesus, the
inner veil
Intercessor, the (Christ)
tertextamental
ipsissima verba
ipsissima vox
Isaian or Isaianic
Jacob’s Trouble
Jehovah
Jeremian or Jeremianic
Jerusalem Council
Jesus Prayer, the
Jewish Feast (Passover)
Jewish New Year (Rosh Hashanah)
Jewish War
Johannine
John the Baptist
John the Beloved
John the Evangelist
Jordan River (but the river Jordan)
Jubilee (year of emancipation)
Judaic
Judaica
Judaism, -ist, -istic
Judaize(r)
Judea(n)
Judeo-Christian
judges, the
Judgment Day
judgment seat of Christ
kerygma
Kethib
Ketubim or Ketuvim
Khirbet
King (God or Jesus)
King James Version
kingdom, the
kingdom age
kingdom of God
kingdom of heaven
kingdom of Israel
kingdom of Satan
King of Glory (Christ)
King of Kings (Christ)
kingship of Christ
Kinsman-Redeemer
koinonia
Koran, koranic (prefer Qur’an)
Lachish letters
Lady, our
lake of fire
Lamb, the (Christ)
Lamb of God
Lamb’s Book of Life
land of Canaan
Land of Promise
land of Israel
Last Day, the
last days, the
Last Judgment, the
last rites
Last Supper, the
last times, the
Latin Rite
Latter Prophets
laver
law (as opposed to grace)
Law, the (Pentateuch)
Law of Moses, the
law of Moses, a (general)
Lawgiver (God)
lemma
Leningrad Codex
Lent(en)
Letter of Aristeas
Letter to the Romans, etc.
levirate
Levitical
Levitical decrees
liberal(ism)
Light (Truth or Christ)
Light of the World (Christ)
lingua franca
Litany, the (Anglican)
Literature, Second Temple, etc.
living God
living Word, the (Bible)
Logos, the
Lord, the
Lord of Hosts
Lord of Lords
Lord’s Anointed, the (Christ)
Lord’s Day, the
lordship of Christ
Lord’s Prayer, the
Lord’s Supper, the
<table>
<thead>
<tr>
<th>Term/Phrase</th>
<th>Synonyms/Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lord’s Table, the lordship</td>
<td>Mount of Transfiguration</td>
</tr>
<tr>
<td>lordship of Christ</td>
<td>Mount Olivet</td>
</tr>
<tr>
<td>lordship salvation</td>
<td>Mount Olivet Discourse</td>
</tr>
<tr>
<td>Lost Tribes</td>
<td>Mount Sinai</td>
</tr>
<tr>
<td>lost tribes of Israel</td>
<td>Muhammad (preferred)</td>
</tr>
<tr>
<td>Love Chapter, the low church</td>
<td>Muratorian Fragment/Canon</td>
</tr>
<tr>
<td>Lower Egypt (political division)</td>
<td>Muslim (preferred)</td>
</tr>
<tr>
<td>lower Galilee (geographical division)</td>
<td></td>
</tr>
<tr>
<td>Lukan</td>
<td></td>
</tr>
<tr>
<td>Magi</td>
<td>Nag Hammadi codices</td>
</tr>
<tr>
<td>Magnificat, the</td>
<td>name of God/Christ, the</td>
</tr>
<tr>
<td>Major Prophets, the (div. of OT)</td>
<td>Nativity, the</td>
</tr>
<tr>
<td>major prophets (people)</td>
<td>nativity of Christ, the</td>
</tr>
<tr>
<td>Majority Text</td>
<td>Near East</td>
</tr>
<tr>
<td>Maker, the (God)</td>
<td>Nebiim or Nevi’im</td>
</tr>
<tr>
<td>mammon</td>
<td>Negev (not Negeb)</td>
</tr>
<tr>
<td>Man, the (Jesus)</td>
<td>Neo-Assyrian period <em>(but Neo-Assyrian Empire)</em></td>
</tr>
<tr>
<td>Man of Sin</td>
<td>Neo-Babylonian period <em>(but Neo-Babylonian Empire)</em></td>
</tr>
<tr>
<td>Man of Sorrows</td>
<td>neo-evangelical</td>
</tr>
<tr>
<td>Marcan or Markan</td>
<td>neo-orthodox(y)</td>
</tr>
<tr>
<td>Masorete</td>
<td>neo-pentecostalism</td>
</tr>
<tr>
<td>masoretic <em>(but Masoretic Text)</em></td>
<td>Neoplatonic</td>
</tr>
<tr>
<td>Mass (liturgy of the Eucharist)</td>
<td>new birth</td>
</tr>
<tr>
<td>matrimony</td>
<td>New City (part of modern Jerusalem)</td>
</tr>
<tr>
<td>Matthean</td>
<td>new covenant (NT)</td>
</tr>
<tr>
<td>Mediator, the (Christ)</td>
<td>new evangelical</td>
</tr>
<tr>
<td>medieval</td>
<td>new heaven and new earth</td>
</tr>
<tr>
<td>Messiah, the (Christ)</td>
<td>New Jerusalem (heaven)</td>
</tr>
<tr>
<td>messiahship</td>
<td>New Testament church</td>
</tr>
<tr>
<td>messianic</td>
<td>Nicene Creed</td>
</tr>
<tr>
<td>Minor Prophets, the (div. of OT)</td>
<td>Nicene fathers</td>
</tr>
<tr>
<td>minor prophets (people)</td>
<td>Ninety-five Theses</td>
</tr>
<tr>
<td>Minuterial</td>
<td>noncanonical</td>
</tr>
<tr>
<td>Minor Prophets, the (div. of OT)</td>
<td>non-Christian (n. and adj.)</td>
</tr>
<tr>
<td>minor prophets (people)</td>
<td>non-Pauline</td>
</tr>
<tr>
<td>Miserere, the</td>
<td>Nonconformism, -ist</td>
</tr>
<tr>
<td>Mishnah</td>
<td>northern kingdom</td>
</tr>
<tr>
<td>modernist(s), -ism</td>
<td>Northwest Semitic</td>
</tr>
<tr>
<td>moon-god</td>
<td>Nunc Dimittis</td>
</tr>
<tr>
<td>Mosaic</td>
<td>Old Assyrian period</td>
</tr>
<tr>
<td>Mosaic covenant</td>
<td>Old Babylonian period</td>
</tr>
<tr>
<td>Mosaic Law (Pentateuch or Ten Commandments)</td>
<td>Old City (part of modern Jerusalem)</td>
</tr>
<tr>
<td>Most High, the</td>
<td>old covenant (OT)</td>
</tr>
<tr>
<td>Mount of Olives</td>
<td>Olivet discourse</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>Omega, the</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>Omnipotent, the</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>One, the <em>(but the one true God)</em></td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>Only Begotten, the</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>only begotten of the Father</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>only begotten Son of God</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>oral law/tradition</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>original sin</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>orthodox(y) (general)</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>Orthodox Jew</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td>outer court (of the Temple)</td>
</tr>
<tr>
<td>Mount of Transfiguration</td>
<td></td>
</tr>
</tbody>
</table>
Palestinian covenant
Palm Sunday
papacy
papyrus (pl. papyri)
parable of the prodigal son, etc.
Paraclete, the
paradise (heaven)
Paradise (Garden of Eden)
Parousia, the
partial Rapture
Paschal Lamb (Jesus)
passion, the
Passion Sunday (fifth Sunday in Lent)
Passion Week
Passover
Passover Feast
Passover Lamb (Jesus)
Pastoral Epistles
Pastoral Letters
Patriarch, the (Abraham)
patriarch, a
patristic(s)
Paul the apostle
Pauline Epistles
Paul’s epistles
Paul’s letters
peace offering
penance
Pentateuch
centecostal (adj.) (but Pentecostal Movement)
 Pentecostal(ism) (noun)
people of God
people of Israel
period (as in Roman period, Chalcolithic period)
person of Christ
(the three) persons of the Trinity
Pessach (Passover)
Petrine
Pharaoh (when used as name without article)
pharaoh, a (general)
pharisaic (attitude)
Pharisaic (in reference to Pharisees)
Pharisee
Pilgrims, the
pillar of cloud
pillar of fire
Poetic Books, the
pope, the
Pope John Paul II
postbiblical
post-Christan
postdiluvian
postexilic
postmillennial(ism)(ist)
post-Nicene fathers
pre-Christian
predestination
premillenarian
premillennial(ism)(ist)
pretribulation(al)
priesthood of believers
priesthood of Christ
Priestly Code
Prime Mover
Prince of Darkness
Prince of Peace (Christ)
Prison Epistles
Prison Letters
Prodigal Son, the
Promised Land (Canaan or heaven)
Promised One, the (Christ)
prophecy of Isaiah (etc.), the
prophet Isaiah (etc.), the
Prophetic Books, the
prophets, the (people)
Prophets, the (books of OT)
Protestant(ism)
Proto-Sinaitic
Proto-Semitic
Providence (God)
providence of God
providential
Psalm 119 (etc.)
Psalms, the (OT book)
psalm, a
psalmic
psalmist, the
Psalter, the (the Psalms)
Pseudepigrapha, the
pseudepigraphal
purgatory
Purim (Feast of Esther)
Qere
Qumran
Qur’an
rabbi
rabbinic(al)
Rapture, the
real presence
Received Text, the
Redeemer, the
Reformation, the
Reformed church
Reformed theology
Reformers
Resurrection, the
resurrection of Christ
Time of the Gentiles, the
time of the judges, the
tomb, the
Torah
Tower of Babel
Transfiguration, the
Transjordan
Tree of Knowledge of Good and Evil
Tree of Life
tribe of Judah
Tribulation, the (historical event)
Trinitarian
Trinity, the
Triumphant Entry
triune God
Twelve, the
twelve apostles, the
Twenty-third Psalm

unchristian
Uncial
ungodly
united kingdom (of Israel)
universal church
universalism, -ist
unscriptural
Upanishads
Upper Egypt (political division)
upper Galilee (geographical division)
Upper Room, the
Upper Room Discourse
Urim and Thummim

vacation Bible school
Vedas, Vedic
viaticum
Victor, the (Christ)
Vine, the (Christ)
Virgin Birth, the
Virgin Mary, the
visible church
Vulgate

wadi
Wadi Qelt, etc.
Water of Life (Christ)
Way, the (Christ)
Way, the Truth, and the Life
West Semitic
Western church/text
Western Rites
Westminster Catechism
whole burnt offering
Wicked One, the (Satan)
Wisdom Literature, the
wise men

Word, the (Bible or Christ)
Word made flesh (Christ)
Word of God (Bible)
Word of Life
Word of Truth, the
Writings, the
Yahweh
Year of Jubilee
Yom Kippur (Day of Atonement)
Yuletide
Zealots
Detroit Baptist Theological Seminary

HOLY SPIRIT BAPTISM

by

John Doe

Systematic Theology II: 331, 7:30 A.M.

Dr. McCune

April 28, 1985
THE USE OF THE OLD TESTAMENT IN
THE BOOK OF HEBREWS

by
John Doe

Submitted in partial fulfillment of requirements for the degree of Master of Theology at Detroit Baptist Theological Seminary
May 1984
In the Gospels Jesus makes reference to the blasphemy against the Holy Spirit, or, as it is often called, the unpardonable sin. The interpretation of Jesus’ words and their application has been a problem throughout the church’s history. The purpose of this dissertation was to examine Jesus’ statements from a detailed historical, exegetical, and theological perspective in order to hopefully shed new light on the problem and come to a conclusion which is fully supported by all the data.

The first step was to undertake a historical survey of how the sin has been interpreted in church history. Next, the passages in the Gospels themselves were studied. This involved a detailed exegesis of the accounts in Matthew, Mark, and Luke. After the Gospels had been dealt with, attention was turned to Hebrews 6 and 1 John 5:16 since these passages are sometimes thought to be also referring to the blasphemy against the Holy Spirit. Although a detailed exegesis of these passages was not attempted, it was demonstrated that neither of these passages had any bearing upon the interpretation of the sin in the Gospels. Finally, the historical and exegetical data from the previous chapters was brought to bear on a fresh analysis of the sin. The major areas of debate were considered under the headings of four questions: (1) What is the precise nature of the sin? (2) Why is the sin unpardonable? (3) Who can commit the sin? (4) Can the sin be committed today?

It was concluded that the sin consisted in blaspheming the miracle-working power of the Holy Spirit. The sin is never forgiven because God chooses not to grant repentance for this sin and the sinner simply remains in his depraved condition. It was also shown that only unbelievers are capable of committing the sin. Because of the nature of the sin itself, it can only be committed during a period of supernatural sign-miracles such as during the ministry of Jesus, his Apostles, or possibly during the future ministry of the two witnesses in Revelation 11.
Accepted by the Faculty of Detroit Baptist Theological Seminary

in partial fulfillment of requirements for the degree

Master of Theology

Adviser

Adviser
# TABLE OF CONTENTS

LIST OF ABBREVIATIONS .................................................................................................. iii

Chapter

I. INTRODUCTION ..............................................................................................................1

II. HISTORY OF INTERPRETATION ..................................................................................3

   Early Church ..................................................................................................................3
   Nonspecific Views .........................................................................................................4
   A Generalized Sin .........................................................................................................6
   Middle Ages ...................................................................................................................7
   Modern Church ............................................................................................................10

III. EXEGESIS OF MATTHEW 12:22–32 ............................................................................11

   The Miracle of Jesus (22–23) .....................................................................................11
   Verse 22 ......................................................................................................................12
   Verse 23 ......................................................................................................................15
   The Charge of the Pharisees (24) ...............................................................................18
   Textual Variants ..........................................................................................................18
   Verse 24 ......................................................................................................................19
   The Refutation by Jesus (25–30) ...............................................................................24

IV. INTERPRETATION OF THE BLASPHEMY AGAINST THE HOLY SPIRIT............27

   What Is the Precise Nature of the Blasphemy Against the Holy Spirit? .....................27
   Rejection of the Convicting Work of the Spirit ............................................................27
   Attacking the Divine Power and Nature of Christ .......................................................29
   Attributing the Spirit’s Work to Satan .........................................................................31
   Attributing the Miracles of Christ to Satan .................................................................34
   Blaspheming the Miracle-Working Power of the Spirit ...............................................35
   Why is the Sin Unpardonable? ....................................................................................38
   Who Can Commit the Sin? .........................................................................................40
   Can the Sin Be Committed Today? ............................................................................42

V. CONCLUSION ..................................................................................................................44

BIBLIOGRAPHY ..............................................................................................................46
# LIST OF ABBREVIATIONS

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AJSL</strong></td>
<td><em>American Journal of Semitic Languages</em></td>
</tr>
<tr>
<td><strong>ANET</strong></td>
<td>James Pritchard, ed., <em>Ancient Near Eastern Texts</em></td>
</tr>
<tr>
<td><strong>BDB</strong></td>
<td>Francis Brown, S. R. Driver, C. A. Briggs, <em>Hebrew and English Lexicon of the Old Testament</em></td>
</tr>
<tr>
<td><strong>BHS</strong></td>
<td><em>Biblia Hebraica Stuttgartensia</em></td>
</tr>
<tr>
<td><strong>BJRL</strong></td>
<td><em>Bulletin of the John Ryland’s University Library of Manchester</em></td>
</tr>
<tr>
<td><strong>CBQ</strong></td>
<td><em>Catholic Biblical Quarterly</em></td>
</tr>
<tr>
<td><strong>ExpTim</strong></td>
<td><em>Expository Times</em></td>
</tr>
<tr>
<td><strong>ICC</strong></td>
<td>International Critical Commentary</td>
</tr>
<tr>
<td><strong>Int</strong></td>
<td><em>Interpretation</em></td>
</tr>
<tr>
<td><strong>JBL</strong></td>
<td><em>Journal of Biblical Literature</em></td>
</tr>
<tr>
<td><strong>JETS</strong></td>
<td><em>Journal of the Evangelical Theological Society</em></td>
</tr>
<tr>
<td><strong>JTS</strong></td>
<td><em>Journal of Theological Studies</em></td>
</tr>
<tr>
<td><strong>NICNT</strong></td>
<td>New International Commentary on the New Testament</td>
</tr>
<tr>
<td><strong>NIV</strong></td>
<td><em>New International Version</em> (NT 1973; OT 1978)</td>
</tr>
<tr>
<td><strong>PEQ</strong></td>
<td><em>Palestine Exploration Quarterly</em></td>
</tr>
<tr>
<td><strong>TDNT</strong></td>
<td>G. Kittel and G. Friedrich, eds., <em>Theological Dictionary of the New Testament</em></td>
</tr>
<tr>
<td><strong>VT</strong></td>
<td><em>Vetus Testamentum</em></td>
</tr>
</tbody>
</table>
PAPER TITLE

As a section heading, the paper title appears in ALL CAPS preceded by a two-inch upper margin and followed by two blank single-spaced lines. It is followed immediately by the first major heading, usually the introduction. Major headings appear in bold font. Bold font appears nowhere else in the paper. No heading should exceed 5 inches. If a heading exceeds this length, divide into two lines in an inverted pyramid, using single spacing.

First Level Subheading

All headings are preceded by two blank single-spaced lines and followed by one blank single-spaced line. Major headings and centered subheadings are capitalized in headline style, that is, capitalize the initial letter of the first and last words and of all words except articles, prepositions of four letters or fewer, and coordinate conjunctions.¹

SECOND LEVEL SUBHEADING

Second level subheadings are exactly like the first level except they are not italicized.

Third level subheading

Third level subheadings appear on the left margin in sentence capitalization style.

Fourth level subheading

Fourth level subheadings are exactly like the third level except they are not italicized.

Term papers of normal classroom length do not require additional subheadings.

¹Footnotes are indented ½ inch. The text begins immediately after the footnote number (the default setting on Word leaves a space). Footnotes appear in either 10 or 12 point font at to the preference of the writer. Footnotes are separated from the text by a two-inch separator line and a single space. Footnotes appear at the bottom of the page, even if text fills only part of the page. Separate footnotes from each other by a single space.
Note that the thesis title does not appear in the text of the thesis. Instead, the thesis is written in chapters, each chapter appearing as a section header (ALL CAPS preceded by a two-inch upper margin and followed by two blank single-spaced lines). Chapter titles replace the bold major headings of normal classroom papers, so the latter heading is not used in theses. Note that this requires text between the chapter title and the next subheading: it is not permissible to have two headings following each other without some intervening text.

First Level Subheading

Apart from these changes, the thesis is exactly as the normal classroom paper. No heading or subheading should exceed 5 inches. If a heading exceeds this length, divide into two lines in an inverted pyramid, using single spacing. All headings are preceded by two blank single-spaced lines and followed by one blank single-spaced line. Capitalize centered subheadings in headline style, that is, capitalize the initial letter of the first and last words and of all words except articles, prepositions of four letters or fewer, and coordinate conjunctions.

SECOND LEVEL SUBHEADING

Second level subheadings are exactly like the first level except they are not italicized.

Third level subheading

Third level subheadings appear on the left margin in sentence capitalization style.

Fourth level subheading

Fourth level subheadings are exactly like the third level except they are not italicized.

Theses should be organized so that additional subheadings are unnecessary.
THE PRE-MOSAIC TITHE: ISSUES AND IMPLICATIONS

Introduction

In Leviticus 27 the Mosaic Law expressly commands the practice of tithing, codifying it for all Israel as a combined act of spiritual service and economic obligation for the advancement of the nation. This codification, however, was by no means the birth of the tithe, but a new expression of a more ancient tithe infused with theological significance for the new political entity of Israel.¹

It is well attested that the tithe² was present in the very earliest of cultures—Roman, Greek, Carthaginian, Cretan, Silician, Phoenician, Chinese, Babylonian, Akkadian, and Egyptian—stretching back to the earliest written records of the human race.³ Was the tithe a divinely conceived custom, original with Yahweh and unique in its expression, or was tithing a divine adaptation of an originally pagan custom, bequeathed with theological significance by divine fiat? Further, was the tithe an act of worship alone, or a demonstration of political subservience—a primitive form of taxation? Or was it a combination of the two?

Many scholars (including most liberals) contend that the levitical institution was borrowed strictly from early contemporary heathen practices.⁴ On the other pole, some,


generally more conservative, scholars contend that the universality of the tithe and the exhaustion of attempts to discover its origin within secular sources point to a much more ancient practice—one instituted by God at the very dawn of human history.\(^5\)

To make either claim, one must look to the early chapters of Genesis for clues to the genesis of the tithe. It is, therefore, the purpose of the following essay to probe the OT material, beginning with the sacrificial practices of Cain and Abel, continuing with the unprecedented payment of tithes by Abram to the priest of the most high God, Melchizedek, and concluding with Jacob’s intention to tithe, for clues to the genesis of the pre-Mosaic tithe. This essay will then decide whether sufficient evidence exists to confirm its divine origin, then discuss briefly its relationship to the levitical tithe and its continuing applicability (or non-applicability) today.

### The Giving Practices of Cain and Abel (Genesis 4:3–7)

So it came about in the course of time that Cain brought an offering to the LORD of the fruit of the ground. Abel, on his part also brought of the firstlings of his flock and of their fat portions. And the LORD had regard for Abel and for his offering; but for Cain and for his offering He had no regard. So Cain became very angry and his countenance fell. Then the LORD said to Cain, “Why are you angry? And why has your countenance fallen? If you do well, will not your countenance be lifted up? And if you do not do well, sin is crouching at the door; and its desire is for you, but you must master it.”\(^6\)

In an attempt to establish the continuity of the tithe throughout human history, several older conservative scholars adopted an alternative text and translation to affirm that Cain’s bel’s sacrifices establish tithing as early as Genesis 4. The LXX reading of verse 7 apparently reflects the Hebrew נָשַׁל (to dissect or divide) rather than the MT’s נָשֵׁל (reflected in NASB’s “at the door”). The resulting English translation of verse 7 identifies Cain’s sin as his failure to “divide rightly.” Furthering this conclusion is an alternate reading of a NT text, Hebrews EncJud, s.v. “Tithe,” by M. Weinfeld; IDB, s.v. “Tithe,” by H. H. Guthrie, Jr. Included in this group are all those who view Israel’s “cultus” as evolutionary and not revelational.

\(^5\)Landsell, Sacred Tenth, p. 38; Babbs, Law of the Tithe, pp. 24–25.

\(^6\)All Scripture quotations, unless otherwise noted, are taken from the 1995 edition of NASB.
CHAPTER III
ISSUES IN NT INTERPRETATION

The Nag Hammadi library was discovered over thirty-five years ago, but because all of the tractates have only recently been published, the interpretation of the library is only just beginning. Already, however, some major issues of interpretation in relation to the NT have arisen.

Pre-Christian Gnosticism

Probably most of the discussion about the contents of the library has centered around its contribution to the question of pre-Christian Gnosticism. Until the twentieth century, the prevailing view of Gnosticism was that of the Church Fathers, who held that it was a Christian heresy. Early in this century this view was challenged by the Religionsgeschichtliche Schule or “History of Religions School.” This approach represents the most thorough-going application of a naturalistic historicism to the study of the Bible. It assumes that biblical religion, in both the Old and New Testaments, passed through stages of growth and evolution like all ancient religions, and in this evolution was heavily influenced through interaction with its religious environment. This method involves the consistent application of the principle of analogy to biblical religion: the history and development of biblical religion must be analogous to the history and development of other ancient religions.

The leading spokesmen of the History of Religions School, Wilhelm Bousset (1865–1920) and Richard Reitzenstein (1861–1931), argued upon the basis of Hermetic, Iranian, and Mandaean documents, all of which postdated the NT, that Gnosticism existed prior to

---


Christianity. Rudolf Bultmann adopted the idea of pre-Christian Gnosticism and sought to explain NT Christianity as the result of a syncretistic process which included Gnostic ideas. Most German NT scholars, because of the influence of Bultmann, have assumed a pre-Christian Gnosticism as a basis for their interpretation of the NT. For example, one of Bultmann’s students, Walter Schmithals, seems to be able to find Gnosticism in almost every Pauline letter. A number of Bultmann’s disciples are attempting to use the Nag Hammadi library in order to verify his view of NT Christianity. MacRae has announced in a recent article: “It is my contention here that such evidence as we have now in the Nag Hammadi library tends to vindicate the position of Bultmann.”

Problem of Definition

A vital consideration with regard to the question of pre-Christian Gnosticism is the need for defining Gnosticism itself. Evans has noted that “if Gnosticism is defined broadly then its origins are found to be much earlier and its roots quite diverse. However, if it is defined narrowly, Gnosticism may be viewed as an early Christian heresy and thus subsequent to the origin of Christianity.” Wilson has suggested that one solution to the problem of definition would be to distinguish between Gnosticism and Gnosis: “By Gnosticism we mean the specifically Christian heresy of the second century A.D., by Gnosis, in a broader sense, the whole complex of ideas belonging to the Gnostic movement and


related trends of thought." Unfortunately, some scholars feel that such distinctions are too confining. MacRae refuses to abide by Wilson’s guidelines, suggesting that “it is not the terminology that matters most.” Bultmann uses the term die Gnosis, but his translators render it into English by the term Gnosticism. German scholars prefer to use the term die Gnosis in the widest possible sense.

It is the opinion of this writer that it is essential to follow the distinctions between Gnosis and Gnosticism suggested by Wilson. However, even if the term “Gnosticism” is restricted to the second and third century sects, it is still difficult to come up with a definition which will incorporate the variety of developed Gnostic systems. Yamauchi believes that the essential “element of any developed Gnosticism would be a radical dualism between the divine and the created, inasmuch as a fundamental Gnostic tenet is the view that the creation of the world resulted from ignorance and error.” Wilson has suggested a four-point summary of the second century movement:

(1) A distinction between the unknown and transcendent true God on the one hand and the Demiurge or creator of this world on the other, the latter being commonly identified with the God of the Old Testament; (2) the belief that man in his true nature is essentially akin to the divine, a spark of the heavenly light imprisoned in a material body and subjected in this world to the dominance of the Demiurge and his powers; (3) a myth narrating some kind of pre-mundane fall, to account for man’s present state and his yearning for deliverance; and (4) the means, the saving gnosis, by which that deliverance is effected and man awakened to the consciousness of his own true nature and heavenly origin. This deliverance, and the eventual return of the imprisoned sparks of light to their heavenly abode, means in time the return of this world to its primordial chaos, and is strenuously opposed at all points by the hostile powers.

Wilson’s four basic points are probably as precise as one can be in formulating a definition of Gnosticism which will include all the second century sects. The question then is

---


22 Wilson, Gnosis and the New Testament, p. 4.
BIBLIOGRAPHY


